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Introduction

This manual contains detailed instructions and notes on the operation and use of this machine. For your
safety and benefit, read this manual carefully before using the machine. Keep this manual in a handy
place for quick reference.

Important

Contents of this manual are subject to change without prior notice. In no event will the company be li-
able for direct, indirect, special, incidental, or consequential damages as a result of handling or oper-
ating the machine.

Do not copy or print any item for which reproduction is prohibited by law.

Copying or printing the following items is generally prohibited by local law:

bank notes, revenue stamps, bonds, stock certificates, bank drafts, checks, passports, driver's licenses.
The preceding list is meant as a guide only and is not inclusive. We assume no responsibility for its
completeness or accuracy. If you have any questions concerning the legality of copying or printing cer-
tain items, consult with your legal advisor.

Notes:

Some illustrations in this manual might be slightly different from the machine.
Certain options might not be available in some countries. For details, please contact your local dealer.

Caution:

Use of controls or adjustments or performance of procedures other than those specified in this manual
might result in hazardous radiation exposure.

Two kinds of size notation are employed in this manual. With this machine refer to the metric version.



Trademarks

Microsoft®, Windows®, Windows Server®, and Windows Vista™ are either registered trademarks or
trademarks of Microsoft Corporation in the United States and/or other countries.

Adobe, Acrobat, Adobe Type Manager, Flash, Macromedia, PageMaker, PostScript are either registered
trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries.

PCL® s a registered trademark of Hewlett-Packard Company.
Monotype is a registered trademark of Monotype Imaging, Inc.

Apple, AppleTalk, EtherTalk, Bonjour, Macintosh, Mac OS, and True Type are registered trademarks
of Apple Inc., registered in the U.S. and other countries.

IPS is a trademark or registered trademark of Zoran Corporation and/or its subsidiaries in the United
States or other countries.

UNIX is a registered trademark in the United States and other countries, licensed exclusively through
X/Open Company Limited.

The Bluetooth® word mark and logos are registered trademarks owned by the Bluetooth SIG, Inc. and
any use of such marks by Ricoh Company, Ltd. is under license.

NetWare, IPX, IPX/SPX are either registered trademarks or trademarks of Novell, Inc.

Other product names used herein are for identification purposes only and might be trademarks of their
respective companies. We disclaim any and all rights to those marks.

The proper names of the Windows operating systems are as follows:

The product name of Windows 2000 are as follows:
Microsoft® Windows® 2000 Professional

Microsoft® Windows® 2000 Server

Microsoft® Windows® 2000 Advanced Server

The product name of Windows XP are as follows:
Microsoft® Windows® XP Professional

Microsoft® Windows® XP Home Edition

Microsoft® Windows® XP Media Center Edition
Microsoft® Windows® XP Tablet PC Edition

The product name of Windows Vista are as follows:
Microsoft® Windows Vista™ Ultimate

Microsoft® Windows Vista™ Enterprise

Microsoft® Windows Vista™ Business

Microsoft® Windows Vista™ Home Premium
Microsoft® Windows Vista™ Home Basic

The product names of Windows Server 2003 are as follows:
Microsoft® Windows Server® 2003 Standard Edition

Microsoft® Windows Server® 2003 Enterprise Edition
Microsoft® Windows Server® 2003 Web Edition

Microsoft® Windows Server® 2003 Datacenter Edition

The product names of Windows Server 2003 R2 are as follows:
Microsoft® Windows Server® 2003 R2 Standard Edition

Microsoft® Windows Server® 2003 R2 Enterprise Edition
Microsoft® Windows Server® 2003 R2 Datacenter Edition

Copyright © 2007



Manuails for This Machine

Refer to the manuals that are relevant to what you want to do with the machine.

ﬂlmportant
O Media differ according to manual.

O The printed and electronic versions of a manual have the same contents .

O Adobe Acrobat Reader/Adobe Reader must be installed in order to view the
manuals as PDF files.

O Depending on which country you are in, there may also be html manuals. To
view these manuals, a Web browser must be installed.

«» About This Machine
Be sure to read the Safety Information in this manual before using the machine.
This manual provides an introduction to the functions of the machine. It also
explains the control panel, preparation procedures for using the machine,
how to enter text, and how to install the CD-ROMSs provided.

% Troubleshooting
Provides a guide to solving common problems, and explains how to replace
paper, toner, and other consumables.

« Copy/ Document Server Reference
Explains Copier and Document Server functions and operations. Also refer to
this manual for explanations on how to place originals.

« Facsimile Reference
Explains Facsimile functions and operations.

% Printer Reference
Explains Printer functions and operations.

< Scanner Reference
Explains Scanner functions and operations.

< Network Guide
Explains how to configure and operate the machine in a network environ-
ment, and use the software provided.
This manual covers all models, and includes descriptions of functions and
settings that might not be available on this machine. Images, illustrations, and
information about operating systems that are supported might also differ
slightly from those of this machine.

< General Settings Guide
Explains User Tools settings, and Address Book procedures such as register-
ing fax numbers, e-mail addresses, and user codes. Also refer to this manual
for explanations on how to connect the machine.



% Security Reference
This manual is for administrators of the machine. It explains security func-
tions that you can use to prevent unauthorized use of the machine, data tam-
pering, or information leakage. For enhanced security, we recommend that
you first make the following settings:

¢ Install the Device Certificate.
* Enable SSL (Secure Sockets Layer) Encryption.

¢ Change the user name and password of the administrator using Web Im-
age Monitor.

For details, see “Setting Up the Machine”, Security Reference.

Be sure to read this manual when setting the enhanced security functions, or

user and administrator authentication.

«+ PostScript 3 Supplement
Explains how to set up and use PostScript 3.

% UNIX Supplement
For “UNIX Supplement”, please visit our Web site or consult an authorized

dealer.
< Other manuals
* Manuals for DeskTopBinder Lite
* DeskTopBinder Lite Setup Guide
¢ DeskTopBinder Lite Introduction Guide
¢ Auto Document Link Guide

& Note
O Manuals provided are specific to machine types.

O “PostScript 3 Supplement” and “UNIX Supplement” include descriptions of
functions and settings that might not be available on this machine.

O The following software products are referred to using general names:

Product name General Name

DeskTopBinder Lite and DeskTopBinder DeskTopBinder
Professional ™

"1 Optional



TABLE OF CONTENTS

Manuals for This Machine..........cco e i
How to Read This Manual ... e 1
SYMDOIS .. e e e e s b e e e e e e eanes 1
Display Panel..... .. s 2
L= I 1= o = S 2
1T aaT o] L1 =Yo I D] o] - S 3
B Y o T = 4
JOD LISE SCIEEN ... e e e e ns 4
Checking Jobs in the Print QUEUE..........ccoociiiiiii e 5
Changing the Order Of JODS .......couiiiiiii e 6
HOIAING Print JODS ..o 6
DeletiNg JODS ... 7
Checking JOD HISTOIY .......coiiiiee e 7
Printer Features MenuU.......... .o r s e s s 8
Setting Paper on the Bypass Tray........cccccciiimmmmmrssssssssss e 1
Setting the Paper Size Using the Control Panel ............cccocooiiiiiiiiiiie e 13
Setting Custom Size Paper Using the Control Panel ...........cccocovveiiiiiiec e 14
Setting Thick Paper or OHP Transparencies Using the Control Panel.................... 15

1. Preparing the Machine

Confirming the Connection Method............cccccoiiiiiniiiiii 17
N T2 Q7] o e 1= Yo7 o] o PR 17
[ Tor= | @7o] 1 =Y o1 o] o 1SR 20
Installing the Printer Driver ... 21
QUICK INSTAILL ... 21
Installing the Printer Driver for the Selected Port..........ccoveviiiiiiiiiiiee e 23
Using as a Windows Network Printer .........cccooviiiimmmmccinssneee e 33
Using as a NetWare Print Server / Remote Printer ........ooommmmmmeeeeernneenneennnnns 35
FOMM FEEA. .. e e e e e e e e e e e e e e s 37
BanNer PAge .......oooiiii e 37
Printing after Resetting the Printer ... 37
Installing the Printer Driver Using USB ... 38
WiINdoWS 2000 - USB ........ooiiiiiiiiiiie et 38
Windows XP, Windows Server 2003/2003 R2 - USB .......coovoiiiiiiiiie e, 40
WINAOWS ViSta - USB .....ooiiiiiiiii ittt 41
Printing with Parallel Connection............cccooiiiiiiiiinnmnn e 42
Printing with Bluetooth Connection...........cccccoiiiiiiincc 44
SUPPOIEA Profil@S.....cooi e 44
Printing with Bluetooth Connection ............cccooiiiiiiiiiii e, 45
Configuring Security Mode Settings.........coociiiiiiiiiiiiie e 46
Printing in the Security MO .........ccoiiiiiiii e 46
Making Option Settings for the Printer.........ccccocoiiimmencciie e 47
Conditions for Bidirectional Communication ............ccccceviiiiiiiee i 47
If Bidirectional Communication Is Disabled.............ccccconiiiiiiiiiiie e, 49
Installing Font Manager 2000...............ccovmmmmmm s 50
Using Adobe PageMaker Version 6.0, 6.5, Or 7.0..........ccccccvmmmmmmnninnnssssnnnnnnnnns 51



2. Setting Up the Printer Driver

PCL - Accessing the Printer Properties........cccoeeeeeeereecreeeeceeeeerreeneeees 53
Windows 2000 - Accessing the Printer Properties..........ccccoveiiiieiiiciiieee e, 53
Windows XP, Windows Server 2003 / 2003 R2

- Accessing the Printer Properties ... 55
Windows Vista - Accessing the Printer Properties ..., 57

RPCS - Accessing the Printer Properties.........cccovvmmiiiinnniiisessnneeeeneen 59
Windows 2000 - Accessing the Printer Properties..........ccccoieeiiiieiiiiiieee e, 59
Windows XP, Windows Server 2003 / 2003 R2

- Accessing the Printer Properties ..o 61
Windows Vista - Accessing the Printer Properties ..o, 63

3. Other Print Operations

Printing a PDF File Directly.......cccccciiiieiiiser s 65
Printing Method ... 65
Using DesKTOPBINAEr LIte .....cccoiieiiiiieieiiee e 66
USING COMIMANGS ....oeieiiiiieiiiee et e e e et sr e e s e e ann e e s anre e e s nnnneas 69

Unauthorized Copy Control ...........ceeeeeeceeeceeeeeeeeeerr e 70
Using [Data security for COPYING] .......cccouiummmiiiiriiiiieiee e 70
USING [MaSK TYPE:] ..o 72
IMPOMANT NOTICE ....ceeieee e 73

Using the Print JOb FUNCHION........ e 74
Selecting the Initial Print JOb List ........ccuoiiiiiii e 77

Printing from the Print Job Screen ... 78
SAMPIE PrINt. et e e e a e 78
[IoTed(=To [N o] | SO PRSP 82
[ (0] o I = o | SO PO PPPPPRTR 86
LS o] =T I o o USSP 89

Printing from the Jobs Per User ID Screen .........ccccccomiiiiiiiiinnmnssncssnnnnennn 93
Printing the Selected Print JOD ... 93
Printing All Print JODS .....coooriei e 95

FOrm Feed........oiir s 97
Printing from a Selected Tray........ccooiiiiiiiie e 97
Canceling @ Print JOD .......ooi e 98

Canceling @ Print JOD ... 929
Canceling a Print Job Using the Control Panel ...........cccooviiiiiiiiiiieee e 99
Windows - Canceling a Print Job from the computer ... 100

Checking the Error LOg ........ccoucciimmmmmiiiiniinsssss s nsssssssssssss s s ssssssnns 101

SPOOI PrintiNg ....ccoeiiiiiiieinr e 102

User Defined Pages ........cccoovinmiiniiinssnrs s s s sssssnnnes 103

Printing with the FiniSher.......... e 104
=T o] - PRSPPI 105
[ 0T o PRSP 107
(@7 ]| = S 109

0 03 - 111

04 F=1 o 11 ¢ | o ' [ 115
NO SlIP SNEES ... 115
Inserting chapter slip SHEEtS ........ooi i 116



ST 17 o 1 1= = 117

=1 o TR 4 1= N 118
7 o] o 119
FOIAING POSHIONS ....cciiiiiiieiiee e 119
Notes on the Z-fold FUNCHION ..........iiiiiie e 120

4. Saving and Printing Using the Document Server

Accessing the Document Server.........iiiiieiieecescsces e 121

5. The Functions and Settings of the Machine

Mainframe.......cco s 123
FUNCHIONS ...t e e e e e a e e e e e e neee 123
INEEITACE .. et 123

List of the Setting ltems ... e 124
WeDb IMage MONMOL .......ooiii e 124
L0 1= PRSPPI 128
Settings that can be used with PostScript 3........cccoviiiiii e 129

6. Appendix

Notes to Users of the PostScript 3 Driver ... 131

SPeCifiCatioNS......ccccciiieeee e ———————— 136
100} 1o} o 1= T SRR 137



Vi



How to Read This Manual

Symbols

This manual uses the following symbols:

/\ WARNING:
Indicates important safety notes.

Ignoring these notes could result in serious injury or death. Be sure to read these
notes. They can be found in the “Safety Information” section of About This Machine.

/\ CAUTION:
Indicates important safety notes.
Ignoring these notes could result in moderate or minor injury, or damage to the

machine or to property. Be sure to read these notes. They can be found in the
“Safety Information” section of About This Machine.

*gklmportant

Indicates points to pay attention to when using the machine, and explanations
of likely causes of paper misfeeds, damage to originals, or loss of data. Be sure
to read these explanations.

& Note

Indicates supplementary explanations of the machine’s functions, and instruc-
tions on resolving user errors.

A Reference

This symbol is located at the end of sections. It indicates where you can find fur-
ther relevant information.

[]

Indicates the names of keys that appear on the machine’s display panel.

[]

Indicates the names of keys on the machine’s control panel.



Display Panel

This section describes configuration using the display panel when the printer

function is selected.

Initial Display

ﬁ*lmportant

O The machine switches to offline when you make settings when the machine is on-
line. After you complete the setting, the machine switches to online automatically.

O If you make a setting when the machine is offline, it will stay offline afterwards.
O The function items displayed serve as selector keys. You can select or specify

an item by pressing it lightly.

O When you select or specify an item on the display panel, it becomes highlighted.

O Keys dimmed (for example,

) cannot be used.

= onne
2 E WPaver Tray Status
‘ 1D 2003U0 =0
— Wworfine | A4 A4 A3 A4 8

PJob Lists & Error Log
4 Print Jobs

= Job Reset

| frorlos J

_ _ by ity

5

1. Operational status or messages

Displays current machine status, such as
“Ready”, “Offline”, and “Printing...”. In-
formation about the print job (user ID and
document name) appears in this section.

2. [ b Online]/[k=Offline]
When you press these keys, the machine
switches between online and offline.

When the machine is online, it can re-
ceive data from the computer.

When the machine is offline, it cannot re-
ceive data from the computer.

3. [Form Feed]

Press to print all the data left in the ma-
chine's input buffer.

¢ When the machine is online, the status
appears dimly.

¢ This function is not available with the
RPCS printer language.

ANW002S

4. [Job Reset]

Press to cancel the current print job.

If you press it when the machine is offline
and Hex Dump is selected, Hex Dump is
canceled.

5. [Print Jobs]

Press to display print jobs sent from a
computer.

6. [Error Log]

Press to display the error logs of print
jobs that sent from a computer.

7. [Spooling Job List]

Press to display spooled jobs.

8. Paper Tray Status indicators
The paper tray settings appear.



& Note

O When the power is turned on, the copier display is shown. This is a factory
default. This initial setting can be changed. See “User Tools (System Set-
tings)”, General Settings Guide.

Simplified Display

This section explains how to switch to the simplified display.

When you press the [ Simplified Display] key, the screen changes from the initial
display to the simplified display. Letters and keys are displayed at a larger size,
making operations easier.

(Wi

ANP042S

< Example of a simplified display

b Online |
| P Paper Tray Status

|
worire | [

Job Reset

& Note
O To return to the initial display, press the [ Simplified Display ] key again.
O Certain keys do not appear on the simplified display.



Job List

Jobs printed using Copy, Document Server, or Printer mode are temporarily
stored in the machine, and then executed in order. The Job List function allows

you to manage these jobs. For example, you can cancel incorrect job settings or
print an urgent document.

& Note
O You cannot use the Job List function when Interrupt Copy is active.

O Documents printed using the facsimile function and scanner function are not

displayed in the job list.

Job List Screen

This section explains displays and icons that appear in the Job List screen.

The Job List screen varies depending on whether [Job Order] is selected with
Print Priority for the System Settings. For details about the setting procedure, see
“Print Priority”, General Settings Guide.

< When [Job Order] is not selected:
The job list is displayed for each of the functions.

Cooier / Docunent Srver Others
Status. No. User Name: File Name Original Quantity_Time Reewired Waiting Jobs: 2
printhg & 304 001 Doc00! 1300 | 6min
001 8305 002 Doc0? 11 J
002 3 306 003 Doc003 11 |
11

BFE003S



% When [Job Order] is selected:
The job list is displayed for all functions in the order of print jobs.

B Job List |
Curren ting Job List Job History
Status. No.. User Name File Name Original Quantity_Time Reewired  Waiting Jobs: 2
printing (B 307 000 DocO0! 110 2min)
001 308 002 Doc002 110 |
002 3309 005 Doc03 1100 ]
"

=
4

BFE004S

@ Switches between job lists for each function.

@ Switches between [Current / Waiting Job List] and [Job History].
® Displays reserved job numbers.

@ Displays the function used to print jobs.
[d: Job printed using copy function.
8: Job printed using printer function.
[} Job printed using Document Server function.
&: Job printed using DeskTopBinder.
&: Job printed using Web Image Monitor.

Checking Jobs in the Print Queue

You can check the contents of jobs in the print queue.

ﬂ Press [Job List].

ﬂ Select the job you want to check.

B Job List
Current / Waiting ist Job History
Status. No. User Name File Name. Original Quantity Time Recuired Waiting Jobs: 2
printins |3 307 001 Docl0! 1100 2min

\
001 @ 308 002 Docl02 1100 J
02 2309 003 Docl03 1100 J

11

B Press [Details], and then check the contents.
ﬂ Press [Exit].



Changing the Order of Jobs

You can change the order in which print jobs in the job list are served:
6 press [yob List].

ﬂ Select the job whose order you want to change.
CEr

| Job History
Status No.  User Name File Name Original Quantity Tine Resuired Waiting Jobs: 2
Printin (& 307001 Doc00! 110 2min Details
| Chenge Order
001 Susoend Frinting
002 3 309 005 Docl03 1100 Delete Reservation
11

B Press [Change Order].
ﬂ Change the order using [Top], [Previous], or [Next].

B Job List

Job History
Status. No. User Name File Name Original Quantity Tire Reswired Waiting Jobs: 2
Pinting |8 307 001 DocO0! 110 2min. [cranse Order
o 8308 002 Doc00?
002 & 309 003 Doc003 110 |

B Press [OK].

Holding Print Jobs

The machine holds jobs that are queued and currently printing.
B press [Job List].
B select the job(s) to hold.

B Job List
Job List Job History

Status. No. User Name File Name Original Quantity Time Reouired Waiting Jobs: 2

Printing 8 307 001 Doc001 1100 2 min. Details

| Change Order

001 & 308 002 Doc002 1 100 Suspend Printing

002 8 309 003 Doc003 1100 Delete Reservation

11

B Press [Suspend Printing].



Deleting Jobs

You can delete job that is queued or currently printing.
& Press [Job List].

ﬂ Select the job you want to delete.
e

Curre

| Job History

Status No. __User Name File Name Original Quantity Tine Recuired  Waiting Jobs: 2

Printis |3 307 001 Doct0! 1100 | 2min) Detils
Change Order

002 8 309 003 Doc003 1100

B Press [Delete Reservation].
ﬂ Press [Yes].

& Note
O To delete multiple print jobs, select them in step B.

Checking Job History

You can view the history contents of printed jobs.
B press [Job List].

E press [Job History].
A list of completed print jobs appears.

B Press [Details] to check the contents of the displayed jobs.
ﬂ Press [Exit].



Printer Features Menu

The following explains settings and meanings of functions on Printer Feature.
Printer Feature screen appears when you press the [ User Tools/Counter] key. For
details, see “Printer Features Menu”, General Settings Guide.

o
*

» List / Test Print

Menu

Description

Multiple Lists

You can print the configuration page and error log.

Configuration Page

You can print the machine's current configuration val-
ues.

Error Log You can print error logs listing all errors that occurred
during printing.
Menu List You can print a Menu List showing the machine's func-

tion menus.

PCL Configuration / Font Page

You can print the current configuration and installed
PCL font list.

PS Configuration / Font Page

You can print the current configuration and installed
PostScript font list.

This menu can be selected only when the optional Post-
Script 3 unit is installed.

PDF Configuration / Font Page

You can print the current configuration and installed
PDF font list.

This menu can be selected only when the optional Post-
Script 3 unit is installed.

Hex Dump

You can print in the Hex Dump mode.

Maintenance

Menu

Description

Menu Protect

This function lets you protect menu settings from acci-
dental change. It makes it impossible to change menu
settings with normal procedures unless you perform
the required key operations.

In a network environment, only administrators can
make changes to menu settings.

List / Test Print Lock

You can lock the [List/ Test Print] menu.

Delete All Temporary Print Jobs

You can delete all print jobs temporarily stored in the
machine.

Delete All Stored Print Jobs

You can delete all print jobs stored in the machine.




% System

Menu

Description

Print Error Report

You can print an error report when a printer or memory
€rror occurs.

Auto Continue

You can select this to enable Auto Continue. When it is
On, printing continues after a system error occurs.

Memory Overflow

Select this to have a memory overflow error report printed.

Job Separation

You can enable Job Separation.

This menu can be selected only when a finisher (optional)
is installed.

Auto Delete Temporary Print Jobs

You can select to automatically delete print jobs tempo-
rarily stored in the machine.

Auto Delete Stored Print Jobs

You can select to automatically delete print jobs stored in
the machine.

Initial Print Job List

You can set the default Printer screen when you press
[Print Jobs].

Memory Usage You can select the amount of memory used in Font Priority
or Frame Priority, according to paper size or resolution.
Duplex You can select to have print on both sides of each page.
Copies You can specify the number of print sets. This setting is
disabled if the number of pages to print has been spec-
ified with the printer driver or another command.
Blank Page Print You can select whether or not to print blank pages.

Toner Saving

Make setting to select either to apply or not to apply
Toner Saving.

Spool Image

You can select to print spool images.

The print job transmitted from the computer is tempo-
rarily stored on the machine's hard disk as bitmap im-
ages that can be printed when transmission is complete.

Reserved Job Waiting Time

You can specify how long the machine waits to receive
a print job before allowing other functions such as the
copier and scanner functions to interrupt it.

Printer Language

You can specify the printer language.

Sub Paper Size You can enable the Auto Substitute Paper Size (A4, LT)
feature.

Page Size You can select the default paper size.

Letterhead Setting You can rotate original images when printing.

When printing, original images are always rotated by
180 degrees. Therefore, output might not be as expected
when printing onto letterhead or preprinted paper re-
quiring orientation. Using this function, you can speci-
fy image rotation.

Bypass Tray Setting Priority

You can specify which of the two options, (Printer)
Driver / Command or Machine Settings, has priority
for determining the paper size for the bypass tray.

Edge to Edge Print

You can select whether or not to print on the entire sheet.

Default Printer Language

You can set the default printer language if the machine
cannot find the printer language automatically.

Tray Switching

You can set to switch the paper tray.




< Host Interface

Menu Description

1/0 Buffer You can set the size of the I/O Buffer. Normally it is not
necessary to change this setting.

I/0 Timeout You can set how many seconds the machine should
wait before ending a print job. If data from another port
usually arrives in the middle of a print job, you should
increase this timeout period.

< PCL Menu

Menu Description

Orientation You can set the page orientation.

Form Lines You can set the number of lines per page.

Font Source You can set the storage location of the default font.

Font Number You can set the ID of the default font you want to use.

Point Size You can set the point size you want to use for the select-
ed font.

Font Pitch You can set the number of characters per inch for the se-
lected font.

Symbol Set You can specify the set of print characters for the select-
ed font.

Courier Font You can select a courier font type.

Extend A4 Width You can extend the printing area width when printing
on A4 sheet with PCL.

Append CR to LF When set to On, a carriage return will follow each line
feed: CR=CR, LF=CR-LF, FF=CR-FF.

Resolution You can set the print resolution in dots per inch.

% PS Menu (optional)

Menu Description
Data Format You can select a data format.
Resolution You can set the print resolution in dots per inch.

% PDF Menu (optional)

Menu Description
Change PDF Password You can set the password for the PDF file executing
PDF Direct Print.
PDF Group Password You can set the group password already specified with
DeskTopBinder Lite.
Resolution You can set the print resolution in dots per inch.

& Note
O Some options do not appear depending optional units or selected printer languages.

O Some options cannot be set depending on security settings.
O For details, see “System Settings”, General Settings Guide.

O For more information about copier features and system settings, see Copy
10 Reference and General Settings Guide.



Setting Paper on the Bypass Tray

This section gives instructions for setting paper on the bypass tray.

For details about paper size and paper type, see “Paper Size and Paper Type”,
About This Machine.

ﬂlmportant
O Paper of the following dimensions can be loaded onto the bypass tray: 100 -
305 mm (3.9 - 12 in.) vertical, and 139.7 - 600 mm (5.5 - 23.7 in.) horizontal.

O If 3,000Sheet-100Sheet Staple Finisher is installed, paper of the following di-
mensions can be loaded onto the bypass tray: 100 - 305 mm (3.9 - 12 in.) ver-
tical, and 139.7 - 458 mm (5.5 - 18.1 in.) horizontal.

O The following functions are disabled when printing from the bypass tray:
* Duplex/Booklet printing
¢ Auto Tray Select
¢ Auto Tray Switching
* Rotating Collate
* Staple (when the optional unit is installed)
* Punch (when the optional unit is installed)
¢ Z-fold (when the optional unit is installed)

ﬂ Open the bypass tray.

ZGUHO030J



g Gently insert paper face up into the bypass tray until the beeper sounds,
and then adjust the paper guides to the paper size.

If the paper size of the paper guide and the paper do not match, skewing and
misfeeds might occur.

Do not stack paper over the limit mark, otherwise a skewed image or mis-
feeds might occur.

Open out the extender to support paper sizes larger than A4 7, 8!/, x11 [5.
Fan the paper to get air between the sheets to avoid a multi-sheet feed.

ANV012S

1. Extender
2. Paper Guide

B Set the paper size using the printer driver or the control panel.

The following procedures are not required if you select [Driver / Command]
from [Bypass Tray Setting Priority] in [System] of [Printer Features]. In that case,
set the paper size using the printer driver.

& Note

O When loading OHP transparencies or thick paper, set paper size and paper
type.

O The number of sheets that can be loaded in the bypass tray depends on the
paper type.

O When loading letterhead paper, pay attention to its orientation. For details,

see “Orientation- Fixed Paper or Two-Sided Paper”, General Settings
Guide.

O For printer driver settings, see the printer driver Help.



Setting the Paper Size Using the Control Panel

Follow the procedure below to set the machine using the control panel when
loading standard size paper onto the bypass tray.

iﬁklmportant

O The following procedures are not required if you select [Driver / Command]
from [Bypass Tray Setting Priority] in [System] of [Printer Features]. In that case,
set the paper size using the printer driver. For details, see General Settings
Guide.

O If you select [Machine Settings] from [Bypass Tray Setting Priority] in [System] of
[Printer Features] (see “System Settings”, General Settings Guide), the settings
made using the control panel have priority over the printer driver settings.

O If the printer driver is not used, select [Machine Settings] from [Bypass Tray Set-
ting Priority] in [System] of [Printer Features] (see “System Settings”, General Set-
tings Guide). Set paper size using the control panel.

0 press the [User Tools/Counter] key on the control panel.
8 Press [System Settings].

B Press the [Tray Paper Settings] tab.

ﬂ Press [Printer Bypass Paper Size].

[ T T oo T

‘ Tray Paper Size: Tray 2

‘ Tray Paper Size: Tray 3

‘ Printer Bypass Paper Size

1 A Provins | W bewd

B Select the paper size.
B Press [OK].

W press the [User Tools/Counter ] key.
The initial screen appears.

& Note
O When loading OHP transparencies or thick paper, set paper size and paper

type.

O For printer driver settings, see the printer driver Help.

13
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Setting Custom Size Paper Using the Control Panel

Follow the procedure below to set the machine using the control panel when
loading custom size paper onto the bypass tray.

ﬂlmportant

O The following procedures are not required if you select [Driver / Command]
from [Bypass Tray Setting Priority] in [System] of [Printer Features] (see “System
Settings”, General Settings Guide). In that case, set the paper size using the
printer driver.

O If you select [Machine Settings] from [Bypass Tray Setting Priority] in [System] of
[Printer Features] (see “System Settings”, General Settings Guide), the settings
made using the control panel have priority over the printer driver settings.

O If the printer driver is not used, select [Machine Settings] from [Bypass Tray Set-
ting Priority] in [System] of [Printer Features] (see “System Settings”, General Set-
tings Guide). Set paper size using the control panel.

0 press the [User Tools/Counter ] key on the control panel.
PJ Press [System Settings].

8 Press the [Tray Paper Settings] tab.

ﬂ Press [Printer Bypass Paper Size].

B Press [Custom Size].

Custom Size

Select vertical or horizontal key.

T <100.0~305.0>
cl
==
~Horizontal .

<139.7-600.0>

If a custom size is already set, press [Change Size].

B Press [Vertical], enter the vertical size of the paper using the number keys,
and then press the [ ] key.

ﬂ Press [Horizontal], enter the horizontal size of the paper using the number
keys, and then press the [ ] key.

8 Press [OK].
The paper sizes entered are displayed.

g Press [OK].

[[D Press the [User Tools/Counter] key.
The initial screen appears.

& Note
O When loading OHP transparencies or thick paper, set paper size and paper

type.
O For printer driver settings, see the printer driver Help.



Setting Thick Paper or OHP Transparencies Using the Control Panel

Follow the procedure below to set the machine using the control panel when
loading thick paper or OHP transparencies onto the bypass tray.

iﬁklmportant

O The following procedures are not required if you select [Driver / Command]
from [Bypass Tray Setting Priority] in [System] of [Printer Features] (see “System
Settings”, General Settings Guide). In that case, set the paper size using the
printer driver.

O If you select [Machine Settings] from [Bypass Tray Setting Priority] in [System] of
[Printer Features] (see “System Settings”, General Settings Guide), the settings
made using the control panel have priority over the printer driver settings.

O If the printer driver is not used, select [Machine Settings] from [Bypass Tray Set-
ting Priority] in [System] of [Printer Features] (see “System Settings”, General Set-
tings Guide). Set the paper size using the control panel.

0 press the [User Tools/Counter] key on the control panel.
8 Press [System Settings].

B Press the [Tray Paper Settings] tab.

ﬂ Press [V Next] to scroll through the list.

B Press [Paper Type: Bypass Tray].

B To print on OHP transparencies, press [OHP (Transparency)] in the [Paper
Type] area. To print on thick paper, press [Thick Paper] in the [Paper Type] area.

Paper Type: Bypass Tray [_cancel K

Select item, then press [OK].
WPever Type

No Display Recycled Paver | [__Preprinted Paver_|

Special Paver Thick Paoer | [ repunched Paper |

Colour Pever 1 Colour Paver 2| [ BondPaver |

Translcent Paper lettartead | [ Cardstock |

Label Power |

Paper Type: Bypass Tray | cancel K

Select item, then press [OK].
PPaper Type

No Display Recycled Paver | [_Preprinted Paver_|

Special Paper Thick Paper Prepunct hed Paper

Colou Pever 1 Colour Paper 2| [ BondPaver |

Trarluct Poer letterhead || Cardstock |

OHP (Transurency) ) Label Pever |

15
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H press [oki.
The paper type selected is displayed.

8 Press the [ User Tools/Counter] key.
The initial screen appears.

4 Note

O The settings made will remain valid until they are reset again. After print-
ing on OHP transparencies or thick paper, make sure to clear settings for
the next user.

O For printer driver settings, see the printer driver Help.



S
1. Preparing the Machine

Confirming the Connection Method

This machine supports network and local connection.

Before installing the printer driver, check how the machine is connected. Follow
the driver installation procedure that is appropriate to the connection method.

Network Connection

This machine can be used as a Windows printing port or network printer.

Using this machine as the Windows printing port

Network connections can be established through Ethernet and IEEE 802.11b.

Available ports are determined based on the combination of Windows operating
system version and connection method used.

SmartDeviceMonitor SmartDeviceMonitor SmartDeviceMonitor SmartDeviceMonitor
for Client for Client for Client for Client
-TCP/IP -TCP/IP -TCP/IP - TCP/IP
-IPP -IPP -IPP -IPP
Standard TCP/IP Standard TCP/IP Standard TCP/IP LPR
LPR LPR LPR
Windows 2000 Windows XP Windows Vista Windows Server

2003/2003 R2

BFE001S

17
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Preparing the Machine

< Windows 2000

Connection Method

Available Ports

Ethernet / IEEE 802.11b

SmartDeviceMonitor for Client port
Standard TCP/IP
LPR port

< Windows XP

Connection Method

Available Ports

Ethernet / IEEE 802.11b

SmartDeviceMonitor for Client port
Standard TCP/IP
LPR port

< Windows Vista

Connection Method

Available Ports

Ethernet / IEEE 802.11b

SmartDeviceMonitor for Client port
Standard TCP/IP
LPR port

< Windows Server 2003/2003 R2

Connection Method

Available Ports

Ethernet / IEEE 802.11b

SmartDeviceMonitor for Client port
Standard TCP/IP
LPR port

/O Reference

See the explanation about how to install the printer driver for each type of
port. For the SmartDeviceMonitor for Client port, see p.23 “Using the Smart-
DeviceMonitor for Client port”.

For the Standard TCP/IP port, see p.29 “Using the Standard TCP/IP port”.

For the LPR port, see p.31 “Using the LPR port”.




Confirming the Connection Method

Using as a network printer

This machine can be used as the Windows network printer, the NetWare print
server, or the NetWare remote printer.

Windows 2000/XP/Vista
Windows Server 2003/2003 R2 NetWare NetWare
Print Server Print Server File Server
5
T S

Windows 2000 Windows XP Windows Vista Windows Server
2003/2003 R2

BFE002S

4]

&

& Note
O In an IPv6 environment, Netware servers cannot be used.

A Reference
See the explanation about how to install the printer driver for each type of
network printer.
For the Windows network printer, see p.33 “Using as a Windows Network
Printer”.

For the NetWare print server and remote printer, see p.35 “Using as a Net-
Ware Print Server / Remote Printer”.

19



20

Preparing the Machine

Local Connection

Local connections can be established via parallel, USB, and Bluetooth connections.
Windows operating system version determines the available connection methods.

e Windows 2000:
USB, Parallel, and Bluetooth connections

e Windows XP:
USB, Parallel, and Bluetooth connections

e Windows Vista:
USB, Parallel, and Bluetooth connections

e Windows Server 2003 / 2003 R2:
USB, Parallel, and Bluetooth connections

p Reference

See the explanation about how to install the printer driver for each method of
connection.

For the USB connection, see p.38 “Installing the Printer Driver Using USB”.
For the parallel connection, see p.42 “Printing with Parallel Connection”.
For the Bluetooth connection, see p.44 “Printing with Bluetooth Connection”.



Installing the Printer Driver

Installing the Printer Driver

This section explains how to install the printer driver. There are two ways to in-
stall the printer driver: using Quick Install, which installs the settings at once, or
installing the appropriate driver according to the port you want to use.

Quick Install

Windows 2000/XP/Vista and Windows Server 2003/2003 R2, users can easily
install this software using the supplied CD-ROM.

Using Quick Install, the PCL printer driver and/or RPCS printer driver, Desk-
TopBinder Lite and SmartDeviceMonitor for Client are installed under network
environment, and the TCP/IP port will be set.

ﬂlmportant
O To install printer driver under Windows 2000/ XP Professional/Vista and

Windows Server 2003/2003 R2, you must have an account that has Manage
Printers permission. Log on as an Administrator.

O If you connect using USB, refer to p.38 “Installing the Printer Driver Using
USB” and install the printer driver.
ﬂ Quit all applications currently running.

B insert the CD-ROM into the CD-ROM drive.
The installer starts.
Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.
8 Select an interface language, and then click [OK].
The default interface language is English.

O click [Quick Install].
The software license agreement appears in the [License Agreement] dialog box.
B After reading the agreement, click [l accept the agreement.], and then click
[Next >].

E Select the machine model you want to use in the [Select Printer] dialog box.

For network connection via TCP/IP, select the machine whose IP address is
displayed in [Connect To].

For parallel connection, select the machine whose printer port is displayed in
[Connect To].

2]
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Preparing the Machine

U crick pinstaln.
The printer driver installation starts.

B click [Finish].
A message about restarting the computer appears. Restart the computer to
complete installation.

g Click [Exit] in the first dialog box of the installer, and then take out the CD-
ROM.

& Note

O To stop installation of the selected software, click [Cancel] before installa-
tion is complete.

O Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

O Select a machine to whose IP address is displayed in [Connect To] to install
SmartDeviceMonitor for Client when using TCP/IP.

p Reference

Quick Install is not available unless bidirectional communication between
the machine and computer is enabled via parallel connection. See p.49 “If
Bidirectional Communication Is Disabled” for details about bidirectional
communication between the machine and computer.



Installing the Printer Driver

Installing the Printer Driver for the Selected Port

Using the SmartDeviceMonitor for Client port

ﬂlmportant

O To install SmartDeviceMonitor for Client under Windows 2000/ XP Profes-
sional/Vista and Windows Server 2003 /2003 R2, you must have an account
that has Manage Printers permission. Log on as an Administrator.

O Install SmartDeviceMonitor for Client before installing the printer driver
when using the SmartDeviceMonitor for Client port.

Installing SmartDeviceMonitor for Client

ﬂ Quit all applications currently running.

B insert the CD-ROM into the CD-ROM drive.
The installer starts.

B Select an interface language, and then click [OK].
The default interface language is English.

ﬂ Click [DeskTopBinder - SmartDeviceMonitor for Client].

B Select an interface language, and then click [Next >].
The default interface language is English.

E The message to quit all other applications appears. Quit all applications,
and then click [Next >].

ﬂ The software license agreement appears in the [License Agreement] dialog
box. After reading through its contents, click [Yes].

B) click [Fullinstall] or [Custom Install].

[Full install] installs all required applications: DeskTopBinder Lite and Smart-
DeviceMonitor for Client.

[Custom Install] installs selected applications.
g Follow the instructions on the display and click [Next >] to proceed next step.

[[D After the installation is completed, select one of the options to restart the
computer either now or later, and click [Complete].

Restart the computer to complete installation.

@ Note

O To stop installation of the selected software, click [Cancel] before installa-
tion is complete.

O Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.
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Preparing the Machine

Changing the port settings for SmartDeviceMonitor for Client

Follow the procedure below to change the SmartDeviceMonitor for Client set-
tings, such as TCP/IP timeout, recovery/parallel printing, and printer groups.

Windows 2000

ﬂ Open [Printers] window from [Start] menu.

ﬂ In the [Printers] window, click the icon of the printer you want to use. On
the [File] menu, click [Properties].

E] On the [Ports] tab, click [Configure Port].
The [Configuration] dialog box appears.

Windows XP, Windows Server 2003/2003 R2:

ﬂ Open the [Printers and Faxes] window from the [Start] menu.
The [Printers and Faxes] window appears.

ﬂ Click the icon of the printer you want to use. On the [File] menu, click [Prop-
erties]. The printer properties appear.

8 Click the [Ports] tab, and then click [Configure Port].
The [Port Configuration] dialog box appears.

Windows Vista:

ﬂ Open the [Control Panel] window from the [Start] menu.
The [Control Panel] window appears.

ﬂ In “Hardware and Sound”, Click [Printer].
The [Printerslwindow appears.

8 Right-click the icon of the printer you want to use, and then click [Properties].

O Click the [Ports] tab, and then click [Configure Port].
The [Port Configuration] dialog box appears.



Installing the Printer Driver

& Note
O For TCP/IP, timeout setting can be configured.

O User, proxy, and timeout settings can be configured for IPP.

O If no settings on the [Recovery/Parallel Printing] tab are available, follow the
procedure below.

@ Click [Cancel] to close the [Port Configuration:] dialog box.

@ Start SmartDeviceMonitor for Client, and then right-click the SmartDe-
viceMonitor for Client icon on the tasktray.

® Point to [Properties], and then click [Extended Features Settings].
@ Select the [Set Recovery/Parallel Printing for each port] check box.
® Click [OK] to close the [Extended Features Settings] dialog box.

O For information about these settings, see “Using SmartDeviceMonitor for
Client”, Network Guide, or SmartDeviceMonitor for Client Help.

Installing the PCL or RPCS printer driver (TCP/IP)

ﬂlmportant

O Toinstall this printer driver under Windows 2000/ XP Professional/ Vista and
Windows Server 2003/2003 R2, you must have an account that has Manage
Printers permission. Log on as an Administrators or Power Users group
member.

ﬂ Quit all applications currently running.

ﬂ Insert the CD-ROM into the CD-ROM drive.
The installer starts.

B Select an interface language, and then click [OK].
The default interface language is English.

ﬂ Click [PCL/RPCS Printer Drivers].

B The software license agreement appears in the [License Agreement] dialog box.
After reading the agreement, click [l accept the agreement.], and then click [Next >].

B Select the printer driver you want to use in the [Select Program] dialog box.

You can select several printer drivers.
U crick [Next >].

8 Select the machine model you want to use.
The printer name can be changed in the [Change settings for 'Printer Name'] box.

25
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Preparing the Machine

g Double-click the printer name to display the printer settings.
The details shown in [Comment:], [Driver:], and [Port:] vary depending on the

operating system, printer model, and port.
m Click [Port:], and then click [Add].
m Click [SmartDeviceMonitor], and then click [OK].

(B Click [TCPAP], and then click [Search].
A list of printers using TCP/IP appears.

[B Select the printer you want to use, and then click [OK].

Only printers that respond to a broadcast from the computer appear. To use
a machine not listed here, click [Specify Address], and then enter the IP address
or host name of the machine.

ﬂ] Check that the port of the selected printer is displayed in [Port:].

iE Set a user code, if necessary.

Up to 8 numeric characters can be entered. No alphabetic character or symbol
can be entered.

[E Select the [Default Printer] check box to configure the printer as default.

W click [Continue].
Installation starts.

[B After the installation is completed, select one of the options to restart the
computer either now or later, and then click [Finish].

Restart the computer to complete installation.

4 Note

O Setting a user code allows a SmartDeviceMonitor for Admin user to dis-
play and check statistics about the number of sheets which each user
prints. For details, see SmartDeviceMonitor for Admin Help.

O Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

O A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run.
If you still want to install the printer driver, use [Add Printer]. See “When a
Message Appears during Installation of the Printer Driver”, Trouble
Shooting.



Installing the Printer Driver

Installing the PCL or RPCS printer driver (IPP)

ﬂlmportant

O To install printer driver under Windows 2000/ XP Professional/Vista and
Windows Server 2003/2003 R2, you must have an account that has Manage
Printers permission. Log on as an Administrators or Power Users group
member.

ﬂ Quit all applications currently running.

ﬂ Insert the CD-ROM into the CD-ROM drive.
The installer starts.

B Select an interface language, and then click [OK].
The default interface language is English.

O click [PCLURPCS Printer Drivers].

B The software license agreement appears in the [License Agreement] dialog box.
After reading the agreement, click [l accept the agreement.], and then click [Next >].

B Select a printer driver you want to use in the [Select Program] dialog box.
You can select several printer drivers.

ﬂ Select the machine model you want to use.
The printer name can be changed in the [Change settings for 'Printer Name'] box.

8 Double-click the printer name to display the printer settings.
The details shown in [Comment:], [Driver:], and [Port:] vary depending on the
operating system, printer model, and port.

g Click [Port:], and then click [Add].

[m Click [SmartDeviceMonitor], and then click [OK].

0 click ey,

[E] In the [Printer URL] box, enter “http://printer's address/printer” as the print-

er's address.

If the server authentication is issued, to enable SSL (a protocol for encrypted
communication), enter “https:/ /printer's address/printer” (Internet Explor-
er 5.01, or a higher version must be installed).

(example IP address: 192.168.15.16)
http://192.168.15.16/printer
https://192.168.15.16/printer

You can enter “http:/ /printer's address/ipp” as the printer's address.
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Preparing the Machine

[B Enter a name for identifying the printer in [IPP Port Name]. Use a name dif-
ferent from the one of any existing port.

If a name is not specified here, the address entered in the [Printer URL] box be-
comes the IPP port name.

[I] Click [Detailed Settings] to make necessary settings.
For information about the settings, see SmartDeviceMonitor for Client Help.

B click [ok).
m Check that the port of the selected printer is displayed in [Port:].

[ﬂ Set a user code, if necessary.

Up to 8 numeric characters can be entered. No alphabetic characters or sym-
bols can be entered.

[B Select the [Default Printer] check box to configure the printer as default.

) click [Continue].
Installation starts.

m After the installation is completed, select one of the options to restart the
computer either now or later, and then click [Finish].

Restart the computer to complete installation.

@ Note

O To stop installation of the selected software, click [Cancel] before installa-
tion is complete.

O Auto Run may not work with certain operating system settings. In that
case, launch “Setup.exe” on the CD-ROM root directory.

O Setting a user code allows a SmartDeviceMonitor for Admin user to dis-
play and check the number of sheets each user prints. For details, see
SmartDeviceMonitor for Admin Help.

O A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run.
If you still want to install the printer driver, use [Add Printer]. See “When a
Message Appears during Installation of the Printer Driver”, Trouble
Shooting.



Installing the Printer Driver

Using the Standard TCP/IP port

This describes how to install the PCL or RPCS printer driver using the TCP/IP
port.

ﬂlmportant

O Toinstall this printer driver under Windows 2000/ XP Professional/ Vista and
Windows Server 2003/2003 R2, you must have an account that has Manage
Printers permission. Log on as an Administrators or Power Users group
member.

O In an IPv6 environment, you cannot use the Standard TCP/IP Port. Use the
SmartDeviceMonitor for Client port.

Installing the PCL or RPCS Printer Driver

ﬂ Quit all applications currently running.

ﬂ Insert the CD-ROM into the CD-ROM drive.

The installer starts.

B Select an interface language, and then click [OK].
The default interface language is English.

O click [PCLRPCS Printer Drivers].

B The software license agreement appears in the [License Agreement] dialog box.
After reading the agreement, click [l accept the agreement.], and then click [Next >].

B Select a printer driver you want to use in the [Select Program] dialog box.
You can select several printer drivers.

U Click [Next >].

8 Select the machine model you want to use.
The printer name can be changed in the [Change settings for 'Printer Name'] box.

g Double-click the printer name to display the printer settings.

The details shown in [Comment:], [Driver:], and [Port:] vary depending on the
operating system, printer model, and port.

[ Click [Port:], and then click [Add].

[ Click [Standard TCP/IP Port], and then click [OK].

Configure the Standard TCP/IP port settings, and then see Windows Help if
[Standard TCP/IP Port] does not appear.
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Preparing the Machine

[B Click [Next >] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.

[B Enter the printer name or IP address in the [Printer Name or IP Address] box.

The [Port Name] text box automatically obtains a port name. Change this name
if necessary.

When the device selection appears, select “RICOH NetworkPrinter Driver C
Model”.

[ Click [Next>].
iE Click [Finish] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.

The installation start dialog box reappears.
[E Check that the port of the selected printer is displayed in [Port:].
[ﬂ Configure the default printer as necessary.

B click [Continue].
The printer driver installation starts.

[E] After the installation is completed, select one of the options to restart the
computer either now or later, and then click [Finish].

Restart the computer to complete installation.

4 Note

O To stop installation of the selected software, click [Cancel] before installa-
tion is complete.

O Auto Run may not work with certain operating system settings. In that
case, launch “Setup.exe” on the CD-ROM root directory.

O A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run.
If you still want to install the printer driver, use [Add Printer]. See “When a
Message Appears during Installation of the Printer Driver”, Trouble
Shooting.



Installing the Printer Driver

Using the LPR port

This describes how to install the PCL or RPCS printer driver using the LPR port.

ﬁklmportant

O Toinstall this printer driver under Windows 2000/ XP Professional/ Vista and
Windows Server 2003/2003 R2, you must have an account that has Manage
Printers permission. Log on as an Administrators or Power Users group
member.

Installing the PCL or RPCS printer driver

ﬂ Quit all applications currently running.

ﬂ Insert the CD-ROM into the CD-ROM drive.
The installer starts.

B Select an interface language, and then click [OK].
The default interface language is English.

ﬂ Click [PCL/RPCS Printer Drivers].

ﬂ The software license agreement appears in the [License Agreement] dialog box.
After reading the agreement, click [l accept the agreement.], and then click [Next >].

B Select a printer driver you want to use in the [Select Program] dialog box.
You can select several printer drivers.

ﬂ Select the machine model you want to use.
The printer name can be changed in the [Change settings for 'Printer Name'] box.

B Click [Next »].

g Double-click the printer name to display the printer settings.

The details shown in [Comment:], [Driver:], and [Port:] vary depending on the
operating system, printer model, and port.

m Click [Port:], and then click [Add].

ﬂ] Click [LPR Port], and then click [OK].
If [LPR Port] does not appear, see Windows Help and install it.

[EJ Enter the printer's IP address in the [Name or address of server providing lpd] box.
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[B Enter “1p” in the [Name of printer or print queue on that server] box, and then click
[OK].
The port is added.

m Check that the port of the selected printer is displayed in [Port:].

[B Configure the default printer as necessary.

[[ﬂ Click [Continue].
The printer driver installation starts.

[ﬂ After the installation is completed, select one of the options to restart the
computer either now or later, and then click [Finish].

Restart the computer to complete installation.

@ Note

O To stop installation of the selected software, click [Cancel] before installa-
tion is complete.

O Auto Run may not work with certain operating system settings. In that
case, launch “Setup.exe” on the CD-ROM root directory.

O A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run.
If you still want to install the printer driver, use [Add Printer]. See “When a
Message Appears during Installation of the Printer Driver”, Trouble
Shooting.



Using as a Windows Network Printer

Using as a Windows Network Printer

This describes how to install the PCL or RPCS printer driver when using the
printer as a Windows network printer.

To use the print server, install the printer driver by selecting “Network printer
server”, and then select the Windows 2000/ XP/Vista or Windows Server
2003/2003 R2 shared printer.

This section assumes that the client has already been configured to communicate
with a Windows 2000/ XP/Vista or Windows Server 2003 /2003 R2 print server.
Do not begin the following procedure before the client is set up and configured
correctly.

iﬁklmportant

O To install the printer driver under Windows 2000/ XP Professional /Vista and
Windows Server 2003/2003 R2, you must have an account that has Manage
Printers permission. Log on as an Administrators or Power Users group
member.

O If you print with a print server connected to the printer using the SmartDe-
viceMonitor port, Recovery Printing and Parallel Printing cannot be used
from the client.

O If you print with a Windows XP/Vista or Windows Server 2003/2003 R2
print server, notification functions of SmartDeviceMonitor may not be used
with the client.

Installing the PCL or RPCS printer driver

ﬂ Quit all applications currently running.

Fd 1nsert the CD-ROM into the CD-ROM drive.
The installer starts.

B Select an interface language, and then click [OK].
The default interface language is English.

ﬂ Click [PCL/RPCS Printer Drivers].

B The software license agreement appears in the [License Agreement] dialog box.
After reading the agreement, click [l accept the agreement.], and then click [Next >].

B Select the printer driver you want to use in the [Select Program] dialog box.
You can select several printer drivers.
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U crick [Next >].

8 Select the [Printer Name] check box to select the printer models you want to use.
The printer name can be changed in the [Change settings for 'Printer Name'] box.

g Double-click the printer name to display the printer settings.

The details shown in [Comment:], [Driver:], and [Port:] vary depending on the
operating system, printer model, and port.

[ Click [Port:], and then click [Add].
[i] Click [Network Printer], and then click [OK].

[ﬂ Double-click the computer name you want to use as a print server in the
[Browse for Printer] window.

[B Select the printer you want to use, and then click [OK].
ﬂ] Check that the port of the selected printer is displayed in [Port:].

[B Configure the user code as necessary.

For an RPCS printer driver, a user code can be set after the printer driver in-
stallation. For information about user code, see the printer driver Help.

m Select the [Default Printer] check box to configure the printer as default.

[ﬂ Click [Continue].
The printer driver installation starts.

[E] After the installation is completed, select one of the options to restart the
computer either now or later, and then click [Finish].

Restart the computer to complete installation.

@ Note

O To stop installation of the selected software, click [Cancel] before installa-
tion is complete.

O Auto Run may not work with certain operating system settings. In that
case, launch “Setup.exe” on the CD-ROM root directory.

O A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run.
If you still want to install the printer driver, use [Add Printer]. See “When a
Message Appears during Installation of the Printer Driver”, Trouble
Shooting.



Using as a NetWare Print Server / Remote Printer

Using as a NetWare Print Server / Remote
Printer

This describes how to set up the Windows computer used as the NetWare client.

iﬁklmportant

O Toinstall this printer driver under Windows 2000/ XP Professional / Vista and
Windows Server 2003/2003 R2, you must have an account that has Manage
Printers permission. Log on as an Administrators or Power Users group
member.

O In an IPv6 environment, Netware servers cannot be used.

The following explanation assumes NetWare Client is installed on the client
computer and the NetWare server environment is correctly set up. Install all nec-
essary client applications before following this procedure.

Set up the printer driver while logging on to the NetWare file server.
The following values are used in the example:

¢ Operating system: Windows 98

¢ NetWare version: 4.1

¢ File server name: CAREE

¢ Queue name: R-QUEUE

) insert the CD-ROM into the CD-ROM drive.
The installer starts.

Auto Run may not work with certain operating system settings. In that case,
launch “Setup.exe” on the CD-ROM root directory.

ﬂ Select an interface language, and then click [OK].
The default interface language is English.

B Click [PCL/RPCS Printer Drivers].

ﬂ The software license agreement appears in the [License Agreement] dialog box.
After reading the agreement, click [l accept the agreement.], and then click [Next >].

B Select the printer driver you want to use in the [Select Program] dialog box.
You can select several printer drivers.

(3 click Next »].

ﬂ Select the [Printer Name] check box to select the printer model you want to use.
The printer name can be changed in the [Change settings for 'Printer Name'] box.
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8 Double-click the printer name to display the printer settings.
The details shown in [Comment:], [Driver:], and [Port:] vary depending on the
operating system, printer model, and port.

g Click [Port:], and then click [Add].

[ Click [Network Printer], and then click [OK].

ﬂ] Double-click the name of the NetWare file server on the network tree.

The created queue is displayed.
[E] Select the print queue, and then click [OK].
[B Check that the port of the selected printer is displayed in [Port:].

0 click [Continue].
The printer driver installation starts.

B click [Finish] in the [Select Program] dialog box.

m After the installation is completed, select one of the options to restart the
computer either now or later, and then click [Finish].

Restart the computer to complete installation.

[ﬂ After restarting the computer, launch the [Printers] window, and then open
the printer properties.

Under Windows XP or Windows Server 2003 /2003 R2, open the printer prop-
erties from the [Printers and Faxes] window.

[B On the [Printer Settings] tab, clear the [Form Feed] and [Enable Banner] check boxes.

Under Windows 2000/ XP/Vista or Windows Server 2003 /2003 R2, click the
[NetWare setting] tab.

Do not select these check boxes since they are automatically selected by the
printer driver. If you select the check boxes, the printer may not print correctly.

m Click [OK] to close the printer properties dialog box.

@ Note

O To stop installation of the selected software, click [Cancel] before installa-
tion is complete.

O The protocol is set to inactive as default. Enable it using Web Image Mon-
itor or Telnet.



Using as a NetWare Print Server / Remote Printer

Form Feed

Do not use NetWare to configure form feed. Form feed is controlled by the print-
er driver on Windows. If NetWare form feed is configured, the printer may not
print properly.

Follow the procedure below to disable form feed according to the operating sys-
tem used:

¢ Under Windows 2000/ XP/Vista or Windows Server 2003 /2003 R2, clear the

[Form feed] check box on the [NetWare Settings] tab in the printer properties di-
alog box.

Banner Page

Do not use NetWare to configure a banner page.

Follow the procedure below to disable banner pages according to the operating

system used:

e Under Windows 2000/ XP/Vista or Windows Server 2003 /2003 R2, clear the
[Enable banner] check box on the [NetWare Settings] tab in the printer properties
dialog box.

Printing after Resetting the Printer

Printer to print server connection requires 30 - 40 seconds to resume after the
printer is reset. During this period, jobs may be accepted (depending on Net-
Ware specifications) but not printed.

To print after resetting the printer as the remote printer, check on the print server
that the remote printer is disconnected, or wait for two minutes before trying to
print.
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Installing the Printer Driver Using USB

This section explains how to install printer drivers using USB.

Before installing, check that only the operating system is running on the compu-
ter and no print jobs are in progress.

The printer drivers can be installed from the supplied CD-ROM provided with
this machine.

Windows 2000 - USB

ﬂlmportant
O To install a printer driver, you must have Administrators privilege. Log on

using an account that has Administrators privilege.

When USB is first used, Found New Hardware Wizard starts, and USB Printing
Support is installed automatically.

If the printer driver has already been installed, plug and play is enabled, and the
icon of the printer connected to the “USB” port is added to the [Printers] window.

If the printer driver is not installed, follow the plug-and-play instructions of the
printer to install it from the supplied CD-ROM.
ﬂ Connect the machine to the computer using the USB cable.

Connect the USB cable firmly.

B 1n the Found New Hardware Wizard display, click [Search for a suitable driver
for my device [recommended]], and then click [Next >].

B Select the [Specify location] check box, and then click [Next >].

O 1nsert the CD-ROM into the CD-ROM drive.
When Auto Run starts, click [Exit].

To disable Auto Run, press the left [Shift] key when inserting the CD-ROM
into the drive and keep it pressed until the computer finishes reading from
the CD-ROM.



Installing the Printer Driver Using USB

B Specify the location where the source files of the printer driver is stored.

If the CD-ROM drive is D, the source files of the printer driver are stored in
the following location:

¢ RPCS
D:\DRIVERS\RPCS\WIN2K_XP\(Language) \DISK1

e PCL 5e
D:ADRIVERS\PCL5E\WIN2K_XP\(Language)\DISK1

e PCL6
D:\DRIVERS\PCL6A\WIN2K_XP\(Language) \DISK1

¢ PostScript 3 (“Scanner Driver and Utilities” CD-ROM)
D:\DRIVERS\PS\WIN2K_XP\(Language)\DISK1

ﬂ Check the printer driver location, and then click [OK].
U Click [Next >].

8 Click [Finish].
If the printer driver has already been installed, plug and play is enabled, and
the icon of the printer connected to the “USB001” port is added to the [Printers]
window.
& Note
O The number after “USB” varies depending on the number of printers connected.
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Windows XP, Windows Server 2003/2003 R2 - USB

ﬂlmportant

O To install a printer driver, you must have Administrators privilege. Log on
using an account that has Administrators privilege.

When USB is first used, Found New Hardware Wizard starts, and USB Printing
Support is installed automatically.

If the printer driver has already been installed, plug and play is enabled, and the
icon of the printer connected to the “USB” port is added to the [Printers] window.

The printer drivers can be installed from the supplied CD-ROM provided with
this machine.

If the printer driver is not installed, follow the plug-and-play instructions of the
printer to install it from the supplied CD-ROM.

ﬂ Connect the machine to the computer using the USB cable.
Connect the USB cable firmly.

g In the Found New Hardware Wizard display, click [Install the software auto-
matically (Recommended)], and then click [Next >].

B insert the CD-ROM into the CD-ROM drive.
If Auto Run starts, click [Cancel], and then [Exit].

To disable Auto Run, press the left [Shift] key when inserting the CD-ROM
into the drive and keep it pressed until the computer finishes reading from
the CD-ROM.

ﬂ Select the [Include this location in the search] check box under [Search for the best driv-
er in these location], and then click [Browse] to select the printer driver location.

If the CD-ROM drive is D, the source files of the printer driver are stored in
the following location:

e RPCS
D:\DRIVERS\RPCS\WIN2K_XP\(Language) \DISK1

e PCL 5e
D:\DRIVERS\PCL5E\WIN2K_XP\(Language)\DISK1

e PCL6
D:\DRIVERS\PCL6\WIN2K_XP\(Language) \DISK1

* PostScript 3 (“Scanner Driver and Utilities” CD-ROM)
D:\ADRIVERS\PS\WIN2K_XP\ (Language) \DISK1

B Check the printer driver location, and then click [Next >].
B Click [Continue].

U click [Finish].
If installation is successful, the icon of the printer connected to the “USB001”
port is added to the [Printers and Faxes] window.

& Note
O The number after “USB” varies depending on the number of printers connected.



Installing the Printer Driver Using USB

Windows Vista - USB

ﬂlmportant

O To install a printer driver, you must have Administrators privilege. Log on
using an account that has Administrators privilege.

If the printer driver is already installed and plug and play is enabled, the icon of
the printer connected to the “USB” port appears in the [Printers] window.

The printer drivers can be installed from the CD-ROM provided with this machine.
If the printer driver is not already installed, follow the printer's plug and play
instructions to install it from the provided CD-ROM.
ﬂ Connect the machine to the computer using a USB cable.

Connect the USB cable firmly.

The [Found New Hardware] dialog box appears.

ﬂ Click [Locate and install driver software (Recommended)].
If the [User Account Control] dialog box appears, click [Continue].

B Click [Don't search online].
A message prompting you to insert the provided CD-ROM appears.

ﬂ Insert the provided CD-ROM into the computer's CD-ROM drive.
The printer driver search begins, and a list of printer drivers appears.

B Select the printer driver you want to use, and then click [Next].
If the [Windows can't verify the publisher of this driver software] message appears,
click [Install this driver software anyway].

(3 click [Close].
If the installation is successful, the icon of the printer connected to the
“USB001” port appears in the [Printers] window.

@ Note

O The number after “USB” varies depending on the number of printers that
the computer is connected to.
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Printing with Parallel Connection

This describes how to install the PCL or RPCS printer driver when using the par-
allel port.

To use a machine connected using a parallel interface, click [LPT1] when install-
ing the printer driver.

ﬁklmportant

O Toinstall this printer driver under Windows 2000/ XP Professional / Vista and
Windows Server 2003/2003 R2, you must have an account that has Manage
Printers permission. Log on as an Administrators or Power Users group
member.

Installing the PCL or RPCS printer driver

ﬂ Quit all applications currently running.

ﬂ Insert the CD-ROM into the CD-ROM drive.
The installer starts.

B Select an interface language, and then click [OK].
The default interface language is English.

ﬂ Click [PCL/RPCS Printer Drivers].

B The software license agreement appears in the [License Agreement] dialog box.
After reading the agreement, click [l accept the agreement.], and then click [Next >].

B Select the printer driver you want to use in the [Select Program] dialog box.

You can select several printer drivers.
U crick [Next >].

8 Select the [Printer Name] check box to select the printer model you want to use.
The printer name can be changed in the [Change settings for 'Printer Name'] box.

g Double-click the printer name to display the printer settings.

The details shown in [Comment:], [Driver:], and [Port:] vary depending on the
operating system, printer model, and port.

m Check that [LPT1:] is shown in [Port:].

ﬂ] Select the [Default Printer] check box to configure the printer as default.



Printing with Parallel Connection

B Click [Finish].
The printer driver installation starts.

[B After the installation is completed, select one of the options to restart the
computer either now or later, and then click [Finish].

Restart the computer to complete installation.

@ Note

O To stop installation of the selected software, click [Cancel] before installa-
tion is complete.

O Auto Run may not work with certain operating system settings. In that
case, launch “Setup.exe” on the CD-ROM root directory.

O A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run.
If you still want to install the printer driver, use [Add Printer]. See “When a
Message Appears during Installation of the Printer Driver”, Trouble
Shooting.
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Printing with Bluetooth Connection

This describes how to print using with Bluetooth devices.

Supported Profiles

Refer the following supported profiles for Bluetooth connection.

% SPP, HCRP

A maximum of two Bluetooth adaptor or Bluetooth-equipped computers
can be connected at the same time using the Bluetooth interface: one by
SPP, one by HCRP.

When connecting more than one Bluetooth adaptor or Bluetooth-equipped
computer at the same time, the first device that establishes connection is se-
lected. When selecting the connection between the other devices, cancel
the first established connection.

SPP connection does not support bidirectional communications.
HCRP connection supports bidirectional communications.

% BIP

For BIP connection, a module including PostScript 3 must be installed in
the machine.

Only one Bluetooth adaptor or Bluetooth-equipped computer can be con-
nected via BIP.

Only JPEG images that can be printed using BIP.

User codes are disabled for BIP.
You cannot print if print functions are restricted.

Some printers do not support BIP.

@ Note

O In this manual, the instruction referred to print using SPP. To print using
HCRP or BIP, see the Help supplied with the Bluetooth adapter you use.



Printing with Bluetooth Connection

Printing with Bluetooth Connection

To install the printer driver, follow the procedure used to install parallel interface.

ﬂlmportant

O Toinstall the printer driver under Windows 2000/ XP Professional / Vista or Win-
dows Server 2003/2003 R2, you must have an account that has Manage Printers
permission. Log on as an Administrators or Power Users group member.

ﬂ Start 3Com Bluetooth Connection Manager.

ﬂ Check that the printer you want to use appears in 3Com Bluetooth Connec-
tion Manager.

E] On the [Tool] menu, click [COM por].

ﬂ Check that the message “Bluetooth Serial Client (COMXx) “ appears under
Client Ports. (X indicates the COM port number used by Bluetooth.)

B click [Close].

(3 on the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

ﬂ Click the icon of the printer you want to use.
8 On the [File] menu, click [Properties].
B click the [Ports] tab.

mUnder [Port], select the [COMx:] check box. X indicates the COM port
number used by Bluetooth.

0 click [ok).
Close the [Printers] window.

& Note

O To always use the same printer, select the [Always use for this connection]
check box.

O System requirements vary depending on the Bluetooth standard and spec-
ifications. For details, see the manuals supplied with each product.

O For information about setting up Bluetooth under other operating systems
or using it with different utilities, see the manuals supplied with those op-
erating systems or utilities.

O If a dialog box appears while transmitting a print job, reestablish network
connection as follows:

@ Select the printer you want to use in the [Printers and Faxes] box.
@ Click [Connect].

O For details, see the manuals supplied with the Bluetooth adaptor or com-

puter equipped with Bluetooth.
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Configuring Security Mode Settings

This describes how to configure the security mode settings.
ﬂ Start 3Com Bluetooth Connection Manager.

ﬂ On the [Tools] menu, click [Security Mode].
The [Security Mode] dialog box appears.

8 Select the security mode in the [Security Mode:] list.

If you click [High], or [Custom], and specify [Link] in the [Custom Settings] dialog
box, enter the Bluetooth password. For information about entering the pass-
word, see p.46 “Printing in the Security Mode”.

For all other security modes and custom settings, no password is required.
For information about each mode, see the manuals supplied with the utility.

O click [ok).
Close the [Security Mode] dialog box.

A Reference
For details about the security mode, see 3Com Bluetooth Connection Man-
ager Help. For details about the password entry which is required to trans-
mit print jobs, see p.46 “Printing in the Security Mode”.

Printing in the Security Mode

This describes how to print in the security mode.

ﬂ Send the print job to the printer in use.
Depending on the computer configuration, the [Connect] dialog box may ap-
pear. If it does, use it to establish the network connection.

ﬂ The [Authentication] dialog box appears.

B Enter the Bluetooth password, and then click [OK].

As the Bluetooth password, enter the last four digits of the machine's serial
number. You can find the serial number on the label attached to the back of
the machine. For example, if the serial number is 00A0-001234, the Bluetooth
password is 1234.

ﬂ The print job is sent.

& Note
O The Bluetooth password differs for each machine and cannot be changed.



Making Option Settings for the Printer

Making Option Settings for the Printer

Make option settings for the machine using the printer driver when bidirectional
communication is disabled.

/O Reference

For details about making option settings for the printer, see p.49 “If Bidirec-
tional Communication Is Disabled”.

Conditions for Bidirectional Communication

Bidirectional communication allows information about paper size and feed di-
rection settings to be automatically sent to the printer. You can check machine
status from your computer.

¢ Bidirectional communication is supported by Windows 2000/XP/Vista and
Windows Server 2003 /2003 R2.

¢ If you use the RPCS printer driver and bidirectional communication is ena-
bled under Windows 2000, the [Change Accessories] tab is unavailable.

@ Note

O The RPCS printer driver supports bidirectional communications and updates
the machine status automatically.

O The PCL printer driver supports bidirectional communications. You can up-
date the machine status manually.

To support bidirectional communication, the following conditions must be met:

% When connected with parallel cables
* The computer must support bidirectional communication.
¢ The machine must support bidirectional communication.
¢ The interface cable must support bidirectional communication.

* The machine must be connected to the computer using the standard paral-
lel cables and parallel connectors.

¢ Under Windows 2000/XP/Vista and Windows Server 2003/2003 R2, [En-
able bidirectional support] must be selected, and [Enable printer pooling] must
not be selected on the [Ports] tab with the RPCS printer driver.
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< When connected with the network
¢ The machine must support bidirectional communication.

e SmartDeviceMonitor for Client included on the CD-ROM must be in-
stalled, and TCP/IP must be used.

e Under Windows 2000/ XP/Vista and Windows Server 2003/2003 R2, [En-
able bidirectional support] must be selected, and [Enable printer pooling] must
not be selected on the [Ports] tab with the RPCS printer driver.

¢ In addition to the above, one of the following conditions must also be met:

¢ The SmartDeviceMonitor for Client port and the TCP/IP protocol must
be used.

¢ IPP port name must include the IP address when using the IPP protocol.

< When connected with USB
The machine must be connected to the computer's USB port using the USB inter-
face cable (for Windows 2000/XP/Vista and Windows Server 2003 /2003 R2).
The computer must support bidirectional communication.

& Note
O Install SmartDeviceMonitor for Client from the supplied CD-ROM.
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If Bidirectional Communication Is Disabled

Set up option settings when bidirectional communications are disabled.

ﬂlmportant

O Under Windows 2000/ XP/Vista and Windows Server 2003 /2003 R2, Manage
Printers permission is required to change the printer properties in the [Print-
ers] folder. Log on as an Administrators or Power Users group member.

O Full Control permission is required to change the printer properties in the
[Printers] (Windows 2000/ Vista) or [Printers and Faxes] (Windows XP and Win-
dows Server 2003/2003 R2) folder. Log on as an Administrators or Power Us-
ers group member.

B on the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

When using Windows XP or Windows Server 2003/2003 R2, point to [Set-
tings] on the [Start] menu, and then click [Printers and Faxes]. The [Printers and
Faxes] window appears.

g Click the icon of the printer you want to use.
B On the [File] menu, click [Properties].

ﬂ Click the [Change Accessories] tab.

If options in the [Change Accessories] tab are disabled, bidirectional connection
is enabled. In this case, no change is necessary for option settings.

If you are using the RPCS printer driver, click the [Change Accessories] tab.

B Select options installed from the [Options] area, and then make the neces-
sary settings.

B Select the total amount of the memory in [Total memory:] when the optional
SDRAM module is added.

ﬂ Under [Paper source tray settings:], click and highlight the tray to be used, and
then select the appropriate size, position, and type for the tray. Select the
[Do not use Auto Tray Select] check box to exclude the tray from the targets of
automatic tray selection.

8 Click [OK] to close the printer properties dialog box.
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Installing Font Manager 2000

ﬂlmportant

O Under Windows 2000/XP or Windows Server 2003 /2003 R2, installing appli-
cations by Auto Run requires administrator privilege. To install a printer
driver by Auto Run, log on using an account that has administrator privilege.

ﬂ Quit all applications currently running.

ﬂ Insert the CD-ROM into the CD-ROM drive.
The installer starts.

B Click [Font Manager 2000].

ﬂ Follow the instructions on the screen.



Using Adobe PageMaker Version 6.0, 6.5, or 7.0

Using Adobe PageMaker Version 6.0, 6.5,
or7.0

Under Windows 2000/XP or Windows Server 2003/2003 R2 with Adobe Page-
Maker, you need to copy PPD files to the PageMaker folder.

PPD files have the .ppd extension in the folder “DRIV-
ERS\PS\WIN9X_ME\ (Language) \DISK1” on the CD-ROM.

The third folder “(Language)” may be substituted by an appropriate language
name.

Copy the .ppd file to the PageMaker folder.

* For PageMaker 6.0 default installation
The directory is “C:\PM6\RSRC\PPD4".

* For PageMaker 6.5 default installation
The directory is “C:\PM65\RSRC\USENGLISH\PPD4".
The “USENGLISH” may vary depending on your language selection.

¢ For PageMaker 7.0 default installation
The directory is “C:\PM7\RSRC\USENGLISH\PPD4".

The “USENGLISH” may vary depending on your language selection.

@ Note

O If the driver is not set correctly after copying the “.ppd” file, printing may not
be performed properly.

O When using PageMaker, the optional features that can be selected by the
printer driver will not be active. The following procedure describes how to
activate the optional printer features.

@ On the [File] menu, click [Print].
The [Print Document] dialog box appears.

® Make the necessary settings in the [Features] box.
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S
2. Setting Up the Printer Driver

PCL - Accessing the Printer Properties

Windows 2000 - Accessing the Printer Properties

Making printer default settings - the printer properties

igklmportant

O To change the printer default settings including option configuration settings,
log on using an account that has Manage Printers permission. Members of the
Administrator and Power Users groups have Manage Printers permission by
default.

O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

ﬂ On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

ﬂ Click the icon of the printer you want to use.

B On the [File] menu, click [Properties].
The printer properties dialog box appears.

ﬂ Make the necessary settings, and then click [OK].

& Note
O Settings you make here are used as the default settings for all applications.

O For details, see the printer driver Help.
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Making printer default settings - printing preferences

ﬂlmportant
O You cannot change the printer default settings for each user. Settings made in

the printer properties dialog box are applied to all users.

ﬂ On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

g Click the icon of the printer you want to use.

B On the [File] menu, click [Printing Preferences...].
The [Printing Preferences] dialog box appears.

ﬂ Make the necessary settings, and then click [OK].

& Note
O Settings you make here are used as the default settings for all applications.

O For details, see the printer driver Help.

Making printer settings from an application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the [Printing Preferences]
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows 2000.

B on the [File] menu, click [Print..].
The [Print] dialog box appears.

ﬂ Select the printer you want to use in the [Select Printer] list.
B Make the necessary settings, and then click [Apply] to start printing.

& Note

O The procedure to open the [Printing Preferences] dialog box may vary de-
pending on the application. For details, see the manuals provided with the
application you use.

O Any settings you make in the following procedure are valid for the current
application only.

O General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.

O For details, see the printer driver Help.



PCL - Accessing the Printer Properties

Windows XP, Windows Server 2003 / 2003 R2 - Accessing the
Printer Properties

Making printer default settings - the printer properties

ﬁ*lmportant

O To change the printer default settings including option configuration settings,
log on using an account that has Manage Printers permission. Members of the
Administrators and Power Users groups have Manage Printers permission
by default.

O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

I] On the [Start] menu, click [Printers and Faxes].
The [Printers and Faxes] window appears.

ﬂ Click the icon of the printer you want to use.

B On the [File] menu, click [Properties].
The printer properties dialog box appears.

ﬂ Make the necessary settings, and then click [OK].

& Note
O Settings you make here are used as the default settings for all applications.

O For details, see the printer driver Help.

Making printer default settings - printing preferences

iﬁklmportant
O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

I] On the [Start] menu, click [Printers and Faxes].
The [Printers and Faxes] window appears.

ﬂ Click the icon of the printer you want to use.

B On the [File] menu, click [Printing Preferences...].
The [Printing Preferences] dialog box appears.

ﬂ Make the necessary settings, and then click [OK].

& Note
O Settings you make here are used as the default settings for all applications.

O For details, see the printer driver Help. 55
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Making printer settings from an application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the [Printing Preferences]
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows XP.

ﬂ On the [File] menu, click [Print...].
The [Print] dialog box appears.

ﬂ Select the printer you want to use in the [Select Printer] list, and then click
[Preferences].

B Make the necessary settings, and then click [OK] to start printing.

& Note

O The procedure to open the [Printing Preferences] dialog box may vary de-
pending on the application. For details, see the manuals provided with the
application you use.

O Any settings you make in the following procedure are valid for the current
application only.

O General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.

O For details, see the printer driver Help.



PCL - Accessing the Printer Properties

Windows Vista - Accessing the Printer Properties

Making printer default settings - the printer properties

ﬁ*lmportant
O To change the printer's default settings (including settings for options), log on

using an account that has Manage Printers permission. Members of the Ad-
ministrators group have Manage Printers permission by default.

O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

ﬂ On the [Start] menu, click [Control Panel].
The [Control Panel] window appears.

ﬂ In “Hardware and Sound”, click [Printer].

B Right-click the icon of the printer you want to use, and then click [Properties].
The [Printer Properties] dialog box appears.

ﬂ Make the necessary settings, and then click [OK].

& Note
O The settings you make here are used as the default settings for all applications.

O For details, see the printer driver Help.

Making printer default settings - printing preferences

ﬂlmportant
O You cannot change the printer default settings for each user. Settings made in

the [Printing Preferences] dialog box are applied to all users.

ﬂ On the [Start] menu, click [Control Panel].
The [Control Panel] window appears.

ﬂ In “Hardware and Sound”, click [Printer].

B Right-click the icon of the printer you want to use, and then click [Printing
Preferences...].

The [Printing Preferences] dialog box appears.
ﬂ Make the necessary settings, and then click [OK].

& Note
O The settings you make here are used as the default settings for all applications.

O For details, see the printer driver Help.
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Making printer settings from an application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the [Printing Preferences]
dialog box from that application. The following procedure explains making
printer settings for Windows Vista WordPad as an example of how to make
printer settings for a specific application.

ﬂ On the [File] menu, click [Print...].
The [Print] dialog box appears.

ﬂ In the [Select Printer] list, select the printer you want to use.

B Click [Preferences].
The [Printing Preferences] dialog box appears.

ﬂ Make the necessary settings, and then click [OK].

& Note

O Procedures for opening the [Printing Preferences] dialog box vary depending on
the application. For details, see the manuals provided with the application.

O Any settings you make using this procedure apply to the current applica-
tion only.

O General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used the defaults when printing
from the application.

O For details, see the printer driver Help.



RPCS - Accessing the Printer Properties

RPCS - Accessing the Printer Properties

There are two dialog box types of the printer properties dialog box.

“Multi-tab” is used as an example in this manual. For details about changing the
dialog box types, see the printer driver Help.

% Multi-tab
This dialog box type is designed for users who often change print settings to g
perform various printing operations.

+ Custom Setting
This dialog box type is designed for users who rarely change print settings.
This type of dialog box may vary depending on the installed options.

Windows 2000 - Accessing the Printer Properties

Making printer default settings - the printer properties

ﬁklmportant

O To change the printer default settings including option configuration settings,
log on using an account that has Manage Printers permission. Members of the
Administrators and Power Users groups have Manage Printers permission
by default.

O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

B on the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

ﬂ Click the icon of the printer you want to use.

8 On the [File] menu, click [Properties].
The printer properties dialog box appears.

When you open the printer properties dialog box initially after installing the
RPCS printer driver, a confirmation message appears. After clicking [OK], the
printer properties dialog box appears.

ﬂ Make the necessary settings, and then click [OK].

& Note
O Settings you make here are used as the default settings for all applications.

O For details, see the printer driver Help.
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Making printer default settings - printing preferences

ﬂlmportant
O You cannot change the printer default settings for each user. Settings made in

the printer properties dialog box are applied to all users.

ﬂ On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

g Click the icon of the printer you want to use.

B On the [File] menu, click [Printing Preferences...].
The [Printing Preferences] dialog box appears.

ﬂ Make the necessary settings, and then click [OK].

& Note
O Settings you make here are used as the default settings for all applications.

O For details, see the printer driver Help.

Making printer settings from an application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the [Printing Preferences]
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows 2000.

B on the [File] menu, click [Print..].
The [Print] dialog box appears.

ﬂ Select the printer you want to use in the [Select Printer] list.
B Make the necessary settings, and then click [Apply] to start printing.

& Note

O The procedure to open the [Printing Preferences] dialog box may vary de-
pending on the application. For details, see the manuals provided with the
application you use.

O Any settings you make in the following procedure are valid for the current
application only.

O General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.

O For details, see the printer driver Help.



RPCS - Accessing the Printer Properties

Windows XP, Windows Server 2003 / 2003 R2 - Accessing the
Printer Properties

Making printer default settings - the printer properties

ﬁ*lmportant
O To change the printer default settings including option configuration settings,

log on using an account that has Manage Printers permission. Members of the
Administrators and Power Users groups have Manage Printers permission
by default.

O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

I] On the [Start] menu, click [Printers and Faxes].
The [Printers and Faxes] window appears.

ﬂ Click the icon of the printer you want to use.

B On the [File] menu, click [Properties].
The printer properties dialog box appears.

When you open the printer properties dialog box initially after installing the
RPCS printer driver, a confirmation message appears. After clicking [OK], the
printer properties dialog box appears.

ﬂ Make the necessary settings, and then click [OK].

& Note
O Settings you make here are used as the default settings for all applications.

O For details, see the printer driver Help.
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Making printer default settings - printing preferences

ﬂlmportant
O You cannot change the printer default settings for each user. Settings made in

the printer properties dialog box are applied to all users.

I] On the [Start] menu, click [Printers and Faxes].
The [Printers and Faxes] window appears.

g Click the icon of the printer you want to use.

B On the [File] menu, click [Printing Preferences...].
The [Printing Preferences] dialog box appears.

ﬂ Make the necessary settings, and then click [OK].

& Note
O Settings you make here are used as the default settings for all applications.

O For details, see the printer driver Help.

Making printer settings from an application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the [Printing Preferences]
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows XP.

B on the [File] menu, click [Print..].
The [Print] dialog box appears.

ﬂ Select the printer you want to use in the [Select Printer] list.
B Make the necessary settings, and then click [Apply] to start printing.

& Note

O The procedure to open the [Printing Preferences] dialog box may vary de-
pending on the application. For details, see the manuals provided with the
application you use.

O Any settings you make in the following procedure are valid for the current
application only.

O General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.

O For details, see the printer driver Help.



RPCS - Accessing the Printer Properties

Windows Vista - Accessing the Printer Properties

Making printer default settings - the printer properties

ﬁ*lmportant
O To change the printer's default settings (including settings for options), log on

using an account that has Manage Printers permission. Members of the Ad-
ministrators group have Manage Printers permission by default.

O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

ﬂ On the [Start] menu, click [Control Panel].
The [Control Panel] window appears.

ﬂ In “Hardware and Sound”, click [Printer].

B Right-click the icon of the printer you want to use, and then click [Properties].
The [Printer Properties] dialog box appears.

When you open the [Printer Properties] dialog box for the first time after install-
ing the RPCS printer driver, a confirmation message appears. After you click
[OK], the [Printer Properties] dialog box appears.

ﬂ Make the necessary settings, and then click [OK].

& Note
O The settings you make here are used as the default settings for all applications.

O For details, see the printer driver Help.
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Making printer default settings - printing preferences

ﬂlmportant
O You cannot change the printer default settings for each user. Settings made in

the [Printing Preferences] dialog box are applied to all users.

ﬂ On the [Start] menu, click [Control Panel].
The [Control Panel] window appears.

ﬂ In “Hardware and Sound”, click [Printer].

B Right-click the icon of the printer you want to use, and then click [Printing
Preferences...].

The [Printing Preferences] dialog box appears.
ﬂ Make the necessary settings, and then click [OK].

& Note
O The settings you make here are used as the default settings for all applications.

O For details, see the printer driver Help.

Making printer settings from an application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the [Printing Preferences]
dialog box from that application. The following procedure explains making
printer settings for Windows Vista WordPad as an example of how to make
printer settings for a specific application.

K on the [File] menu, click [Print..].
The [Print] dialog box appears.

ﬂ In the [Select Printer] list, select the printer you want to use.

B Click [Preferences].
The [Printing Preferences] dialog box appears.

ﬂ Make the necessary settings, and then click [OK].

& Note

O Procedures for opening the [Printing Preferences] dialog box vary depending on
the application. For details, see the manuals provided with the application.

O Any settings you make using this procedure apply to the current applica-
tion only.

O General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used the defaults when printing
from the application.

O For details, see the printer driver Help.



S
3. Other Print Operations

Printing a PDF File Directly

You can send PDF files directly to the machine for printing, without having to
open a PDF application.

ﬂlmportant
O This function is possible only when the optional PostScript 3 unit is installed.

O This function is possible for genuine Adobe PDF files only.

O Version 1.3, 1.4, and 1.5 PDF files are compatible.

O Transparency and JBIG2 (functions of PDF version 1.4) are not compatible.

O PDF version 1.5 exclusive functions are not compatible.

O Some types of High Compression PDF files are not supported. Consult your
sales representative about the supported file types.

@ Note
O Paper size errors may occur when printing on custom size paper.

Printing Method

The following procedures explain the two methods of direct PDF printing - us-
ing DeskTopBinder Lite or by entering commands.
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Using DeskTopBinder Lite

Installing DeskTopBinder Lite

Follow the procedure below to install DeskTopBinder Lite.
ﬂ Quit all applications currently running.

ﬂ Insert the CD-ROM into the CD-ROM drive.
The installer starts.
Auto Run may not work under certain operating system settings. In this case,
launch “Setup.exe” located on the CD-ROM root directory.

B Select an interface language, and then click [OK].

ﬂ Click [DeskTopBinder - SmartDeviceMonitor for Client] , and then click [Next].

B Follow the instructions on the display to install DeskTopBinder Lite.

If you are required to restart the computer after installing DeskTopBinder
Lite, restart the computer and continue the configuration.

DeskTopBinder Lite enhancements

Follow the DeskTopBinder Lite enhancement procedure to print PDF files directly.

I] On the [Start] menu, click [Programs], [DeskTopBinder], and [Extended Features
Wizard].

ﬂ When [Extended Features Wizard] appears, select [Start], and then click [Next]
repeatedly until the [Printing Function3] screen appears.

B On the [Printing Function3] screen, click [Add] to display [PDF Direct Print Properties].

ﬂ Select Driver for This Machine, click [OK], and then click [Next] repeatedly
until [Finish] is displayed.

Click [Finish].



Printing a PDF File Directly

Function Palette

The Function palette contains buttons for functions that are already configured
through DeskTopBinder Lite enhancement. Using these buttons, you can print
Windows files, preview printouts, convert images, and register scanners for doc-
uments without having to open DeskTopBinder Lite. You can also use these
functions simply by dragging a target file to the button corresponding to the re-
quired function and dropping it there.

I] On the [Start] menu, click [Programs], [DeskTopBinder], and [Function Palette].
An icon for the Function palette is added to the task bar displayed at the bot-
tom right of the screen.

ﬂ Right-click the icon that is added to the task bar, and then click [Properties]
to display the Properties screen.

B Click the [Contents] tab, select the [PDF Direct Print] check box at the center,
and then click [OK].

The [Properties] screen closes and the [PDF Direct Print] icon is added to the palette.

PDF Direct Printing

Use the method below to print PDF files directly.

ﬂ Drag the PDF file you want to print to the PDF Direct Printing icon in the
palette and drop it there.

ﬂ [Output File List-PDF Direct Print] is displayed.
Highlight the PDF you want to print, and then click [OK].
The PDF file is printed.
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Printing PDF Password-Protected Documents

Follow the procedure below to print password-protected PDF files.

[I In the Windows [Start] menu, click [Programs], [DeskTopBinder], and [Extended
Features Wizard].

ﬂ When [Extended Features Wizard] appears, select [Start], and then click [Next]
repeatedly until the [Printing Function3] screen appears.

8 On the [Printing Function3] screen, click [Properties...] to display [PDF Direct Print
Properties].

ﬂ Select the [Use PDF Password] check box at the bottom right of the screen, and
then click [OK].

Click [Next] repeatedly until [Finish] appears.
Click [Finish] to close the [Extended Features Wizard] screen.

B Move the PDF file you want to print to the PDF Direct Printing icon on the
palette using a drag-and-drop operation.

[ [output File List-PDF Direct Print] is displayed.
Select the PDF file you want to output to make it reverse video, and then click
[OK].

ﬂ The [PDF Direct Print Properties] screen opens.

Enter the password for the PDF file you want to print in the [PDF Password]
field at the bottom right of the screen, and then click [OK].

The password-protected PDF file is printed.

& Note
O Before printing a password-protected PDF file, perform one of the following;:
* Enter the PDF password in the PDF Direct Printing Properties screen

* Specify a PDF password by selecting [Change PDF Password] in the [PDF
Menu] menu on the control panel of this machine

O If a [PDF Group Password] for the [PDF Menu] menu is assigned to either
DeskTopBinder Lite or the control panel of this machine, a same group
password needs to be assigned to the other.



Printing a PDF File Directly

PDF Direct Print Properties
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1. Setting name:
Displays the plug-in configuration name
(up to 63 single byte characters)

2. Change Icon...

Changes the icon displayed on the tool
bar.

3. Printer name:

Displays a list of RPCS drivers that sup-
port PDF direct printing.

4. Duplex

Prints on both sides of sheets.

5. Layout
Prints multiple pages on a single sheet.

6. Punch

Punch holes in output sheets.

7. Staple
Staple together output sheets.

8. Display this dialog box before
printing

Appears in PDF direct printing mode if
this check box is selected.

ANWO014S

9. Orientation:
Specifies the original's orientation.

10. Number of copies
Specifies the number of copies to print.

11. Collate

Sorts printed sheets.

12. Range

Specifies the print area on each page.

13. Resolution:
Specifies a print resolution.

14. PDF password:

If the PDF file is password-protected, en-
ter the password in this field. Otherwise,
the file cannot be printed.

15. Group password:

If a group password is assigned to Desk-
TopBinder Lite and this machine, enter
the group password in this field. Other-

wise, printing cannot start.

Using commands

You can print PDF files directly, using commands such as “ftp” “sftp”and “Ipr”.

@ Note

O For details about UNIX commands, see Network Guide.
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Unauthorized Copy Control

You can embed patterns and text under printed text to prevent unauthorized
copying of the document. Unauthorized Copy Control consists of two functions:
[Data security for copying] and [Mask type:].

ﬂlmportant
O This function is designed to discourage copying of confidential documents; it

does not prevent unauthorized use of information.

Opening the Unauthorized Copy Control Window

ﬂ In the RPCS printer driver, open the [Printing Preference] window.
B click [Add/iChange Custom Settings...].
B Select the [Unauthorized copy...] check box.

ﬂ Click [Control Settings...].
The Unauthorized Copy Control window appears.

& Note
O For details, see the printer driver Help.

Using [Data security for copying]

You can embed a pattern by setting it in the printer driver.

‘E, Unavtharized copy prevention: Test
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% Setting [Data security for copying] in the printer driver

e Select the [Data security for copying] check box. You can also enter the text in
the [Text:] box.

* You cannot select the [Mask type:] check box at the same time.

e To print a document protected by gray overprint, the machine must be set
up correctly. Consult your administrator.
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% Printing a document using [Data security for copying]

1 2 3

)

AJLO30S

1. The pattern and text you have set 3. The document is blanked by gray
is printed. overprint.

2. The document is copied or stored
in copiers/multifunction machines
which the optional Copy Data Secu-
rity unit is installed.

@ Note

O When printing a document that is set with [Data security for copying], the ma-
chine does not require the optional Copy Data Security unit to be installed.
The Copy Data Security unit is required when copying or storing a document
protected by gray overprint.

O Only the RPCS printer driver is supported.

O You cannot partially embed a pattern and text in a document.
[ Use 182 x 257 mm (7!/4 x 10!/ in.) or larger paper.

O Use ordinary or recycled paper of at least 70% whiteness.

O Duplex printing may interfere with this function as a result of text and pat-
terns being visible through the paper.

O For details about setting [Data security for copying], see the printer driver Help.
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Using [Mask type:]

You can embed patterns and text in a document by setting in the printer driver

to prevent unauthorized copying.

I™ Data secury for copying
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% Setting [Mask type:] in the printer driver
* Select a pattern from [Mask type:], and then enter text in the [Text:] box.
* You can set only [Text:], but [Mask type:] and [Text:] must be set together.

+ Printing a document using [Mask type:]

1 2
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1. The pattern and text you have set
is printed palely.

2. The document is copied, scanned,
or stored in copiers/multifunction
machines.

AJLO31S

3. The pattern and text you have set
appear clearly.



Unauthorized Copy Control

@ Note

a
)
a

Only the RPCS printer driver is supported.
You cannot partially embed patterns and text strings in a document.

To make the embedded pattern clear, set the character size at least 50 pt (pref-
erably 70 to 80 pt) and character angle to between 30 and 40 degrees.

Due to the effects of the settings, the results of copying, scanning, and saving
documents in the document server may vary depending on the machine
model and setting conditions.

Printing with background patterns and text may be slower than normal printing.
For details about setting [Mask type:], see the printer driver Help.

Important Notice

The supplier does not provide warranty regarding the appearance of print
patterns and other copy protection features. The appearance of the print pat-
terns and the performance of Unauthorized Copy Control may vary depend-
ing on the quality of paper used and the machine model and settings.

The supplier takes no responsibility for any damages sustained in connection
with use of or inability to make use of Unauthorized Copy Control print patterns.
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Using the Print Job Function

This describes how to print files stored in the machine.

The following types of printing can be selected using the printer driver: Sample
Print, Locked Print, Hold Print, and Stored Print.

You can print or delete the print jobs saved in the machine which is sent from
computers.

If you select Sample Print, Locked Print, and Hold Print, the print files saved in
the machine are deleted after printing is completed. If you select Stored Print,
the files remain in the machine even after printing is finished.

If you press [Print Jobs] on the Printer screen, the Complete List or the List Per
User ID screen appears depending on which list type you select from [Initial Print
Job List].

| it Print Job Lst. [cancel oK

Select item, then press [OK].

List Per User ID

« Complete List
If you select [Complete List] from [Initial Print Job List], the following screen appears:

16

Print Jobs, Bt = 15

Select job(s).

| [user 0 Date / Time il Narr] Selected e 14

[[® 1254 | 08/26 16:52 | New Horcbad Document _| by 13

1— '@ © 1234 | 08/26 1652 New Horcpad Document | - 12
2 | [P 13| 09/24 00:40  New borcpad Docunent_|

e © | 1254 | 08/24 00:40 | New Horcbad Docunent |
3 DEDC ] © | 1234 __| 08/26 00:40 | New Horcbad Docunent |
4 Do vt ] D | 123 | 08/23 20:29 | New Wordead Document |
5 T 1256 08/25 20329 New Wordpad Docunent | !
6 DSt 88| S5 5 /2> 2028 Ve orabad Dot | Y 10
7 | T 9

= Detils 172 [ ¥ hext

@ Jobs Per User ID
Displays List Per User ID.

® Complete List
Displays all files stored in the machine.

® Locked Print Job List
Displays only Locked Print files stored in the machine.
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@ Sample Print Job List
Displays only Sample Print files stored in the machine.
® Hold Print Job List
Displays only Hold Print files stored in the machine.
® Stored Print Job List
Displays only Stored Print files stored in the machine.
@ Details
Displays details about a selected file.
[APrevious] /[ Y Next]
If the list of files does not fit on the screen, scroll down to view the list.

® [Delete]
Deletes a selected file.

[Print]
Prints a selected file.

@ [Change Password]
Changes or deletes the password of a file if a password is set. To change
the password, press [Change], enter the current password, and then enter
the new password on the confirmation screen. To delete the password,
press [Change], leave the entering/confirming a new password box blank,
and then press the [OK] key.
You can also set passwords to the Stored Print files that do not currently
have passwords.

® [Clear All]
Clears all selections.

® [Select All Jobs]
Selects all files stored in the machine.

Selected:
Displays number of the files selected.

® [Exit]
Returns to the Printer screen.

User ID, Date/Time, and File Name display
Displays the time when the instruction to print the stored files was entered,
the User IDs, and the file names.
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% List Per User ID
If you select [List Per User ID] from [Initial Print Job List], the following screen appears:

Print Jobs [ Bt —3
Select User I
AU jobs for ts selected user ID will be printed.
Clear Corpletelist e 4]
.
= e I List Per User [} et 55
Print All lobs e 5

! S
® User ID
Displays the User IDs who sent files to the machine.
@ [Clear]
Deselects a selection.
® [Exit]

Returns to the Printer screen.
@ [Complete List]
Displays all print jobs.
® [List Per User ID]
Displays the print job list of each ID.

® [Print All Jobs]
Prints all selected type of files sent by the user ID.

@ [APrevious] /[ Next]
If the list of files does not fit on the screen, scroll down to view the list.

@ Note

O Multiple files can be selected on the Print Jobs screen. To clear selection, press
the selected print jobs again.

O The display is not updated if a new file is stored while the list of stored files
is displayed. To update the display, press [Exit] to return to the Printer
screen, and then press [Print Jobs] again.

O If alarge number of print jobs are stored in the machine, processing may slow
temporarily, depending on which functions are used.

O If you press [List Per User ID] in the Complete List screen, the screen switches
to the List Per User ID screen where [Back] appears at the bottom right. Press
[Back] to switch to the Complete List screen.

A Reference
p-78 “Sample Print”
p-82 “Locked Print”
p-86 “Hold Print”
p-89 “Stored Print”
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Selecting the Initial Print Job List

Follow the procedure below to set the initial Print Jobs screen, and to show it.

Selecting the Initial Print Job List

ﬂ Press the [ User Tools/Counter] key.

ﬂ Press [Printer Features].
The Printer Features menu appears

E] On the [System] tab, press [Initial Print Job List].
O select either [Complete List] or [List Per User ID].

ital Print Job Lt el ][ k]

Select item, then press [OK].

rrelete List List Per User ID

After configuring the settings, the selected type of print job list is displayed.

Displaying a Print Job List

B press [print Jobs].

- WPaper Tray Status
10200340
i Offline A4 A4 A3

B Joh Lists & Error Log

Job Reset ‘ ‘ Print Jobs | | E

Either the Complete List or List Per User ID screen appears.
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Printing from the Print Job Screen

This section gives instruction about Sample Print, Locked Print, Hold Print, and
Stored Print.

Sample Print

Use this function to print only the first set of a multiple-set print job. After you
have checked the result, remaining sets can be printed or canceled using the ma-
chine's control panel. This can reduce misprints due to mistakes in content or
settings.

ﬂlmportant
O A Sample Print file cannot be stored if:

¢ the total number of Sample Print, Locked Print, Hold Print, and Stored
Print files in the machine is over 100. (The maximum number varies de-
pending on the volume of data in files.)

¢ the file contains over 2,000 pages.
* sent or stored files in the machine contain over 10,000 pages in total.

& Note

O If a Sample Print file has not been stored properly, check the error log on the
display panel.

O Even after you turn off the machine, stored documents in the machine re-
main. However, the [Auto Delete Temporary Print Jobs] or [Auto Delete Stored Print
Jobs] settings are applied first.

O If the application has a collate option, make sure it is not selected before send-
ing a print job. By default, Sample Print jobs are automatically collated by the
printer driver. If a collate option is selected from the application's [Print] dia-
log box, more prints than intended may be produced.

O If the first set of the Sample Print files is not as you expected and you do not
want to print remaining sets, delete the Sample Print file using the display
panel. If you print the remaining sets of the Sample Print file, the job in the
machine is deleted automatically.

O For details about the [Auto Delete Temporary Print Jobs] and [Auto Delete Stored
Print Jobs], see “System Settings”, General Settings Guide.

p Reference

For details about the error log on the control panel, see p.101 “Checking the
Error Log”.
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Printing a Sample Print file

The following procedure describes how to print a Sample Print file with the PCL
6/5e and the RPCS printer driver. For information about how to print a Sample
Print file with the PostScript 3 printer driver, see PostScript 3 Supplement in-
cluded as a PDF file on the CD-ROM.

iﬁklmportant

O Applications with their own drivers, such as PageMaker, do not support this
function.

O If you are using Mac OS X, you need Mac OS X v10.2 or higher to use this
function.

ﬂ Configure Sample Print in the printer driver's properties.
For details about configuring the printer drivers, see the relevant Help files.

ﬂ Start printing from the application's [Print] dialog box.
Make sure to set more than two copies.
The Sample Print job is sent to the machine, and the first set is printed.

B On the machine's control panel, press the [ Printer] key to display the Printer
screen.

O press [Print Jobs].

MPaper Tray Status
TELD 21030
HrOfline A4 A4 A3

P lob Lists & Error Log

Joh Reset ‘ ‘ Print Jobs | | E

A list of print files stored in the machine appears.

B press [sample Print Job List].

Print Jobs Exit

Select job(s).
All Jobs

User ID Date / Time  File Name Selected: 0
B | 8888 | 08/24 16:57 | New Horcbad Docunent
Jobs Per User D ® | 1234 | 08/24 16:52 | New Horcbad Docunent

[ 1234 08/24 16:52 | New Wordpad Document

Complete List
& Locked Print Job List

[ Sanple Print Job List

(3 Fold rint Jb List
9 Store Print Job List

Detalls 1”1

A list of Sample Print files stored in the machine appears.
Depending on the security settings, certain print jobs may not be displayed.

79



80

Other Print Operations

E Select the file you want to print, and press [Print].

Prnt Jobs et ]

Select job(s).

s UserD  Date/Time FileName Selected: 1
© | 8888 | 08/24 16:57 | New Hordoad Docunent | | Select All lobs

Jobs Per User ID © | 1254 | 08/24 16:52 | New Worcbad Docunent | Clear All

[ comitelst_| [ 133 | 08/2 1652 New Worchad Docunent

53 Stored Print Job List Print.
Details ”n Delete
1500 200
Syt 16:53

ﬂ Enter the new number of sets using the number keys.

@ Are you sure you want to print
the following?

User ID: 1234
File Name: Microsoft Word ~ Print_001.doc

The set quantity can be changed.

> _2 a-9%

You can enter up to 999 sets.
Press the [Clear/Stop ] key to correct any entry mistakes.

8 Press [Yes].
The remaining sets are printed.
Press [No] to cancel printing.

4 Note

O If you select multiple documents and do not specify the number of sets on
the confirmation screen, one set less than the number specified on the com-
puter is printed for every selected document. If the number of sets speci-
fied on the computer is “1”, one set each is printed for every document.

O When the number of set quantity is changed, the changed quantity is ap-
plied to all selected files.

O When printing is completed, the stored file will be deleted.

O To stop printing after printing has started, press [Exit] until the Printer
screen appears, and then press [Job Reset]. The file will be deleted.



Printing from the Print Job Screen

Deleting Sample Print files

If you are not satisfied with the sample printout, you can delete the Sample Print
file, revise it and print it again until the settings are suitable.

0 press the [Printer] key to display the Printer screen.

EJ press [Print Jobs].
A list of the print files stored in the machine appears.

B Press [Sample Print Job List].
A list of Sample Print files stored in the machine appears.
Depending on the security settings, certain print jobs may not be displayed.

ﬂ Select the file you want to delete, and then press [Delete].
The delete confirmation screen will appear.

B Press [Yes] to delete the file.
The selected file is deleted.

& Note
O If you do not want to delete the file, press [No].
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Locked Print

Use this function to maintain privacy when printing confidential documents on
the machine over a shared network. Usually, it is possible to print data using the
display panel once it is stored in this machine. When using Locked Print, it is not
possible to print unless a password is entered on the machine's display panel.
Your confidential documents will be safe from being viewed by other people.

ﬂlmportant
O A Locked Print file cannot be stored if:

* the total number of Sample Print, Locked Print, Hold Print, and Stored
Print files in the machine is over 100. (The maximum number varies de-
pending on the volume of data in files.)

¢ the file contains over 2,000 pages.
* sent or stored files in the machine contain over 10,000 pages in total.

& Note

O If a Locked Print file has not been stored properly, check the error log on the
display panel.

O Even after you turn off the machine, stored documents remain. However, the
[Auto Delete Temporary Print Jobs] or [Auto Delete Stored Print Jobs] settings are
applied first.

O If the application has a collate option, make sure it is not selected before send-
ing a print job. Locked Print jobs are automatically collated by the printer
driver as default. If a collate option is selected in the application print dialog
box, more sets than intended may be printed.

O After the Locked Print file is printed, the job is automatically deleted.

3 For details about the [Auto Delete Temporary Print Jobs] and [Auto Delete Stored
Print Jobs], see “System Settings”, General Settings Guide.

p Reference

For details about the error log on the display panel, see p.101 “Checking the
Error Log”.



Printing from the Print Job Screen

Printing a Locked Print file

The following procedure describes how to print a Locked Print file with the PCL
6/5e and the RPCS printer driver. For information about how to print a Locked
Print file with the PostScript 3 printer driver, see PostScript 3 Supplement in-
cluded as a PDF file on the CD-ROM.

iﬁklmportant

O Applications with their own drivers, such as PageMaker, do not support this
function.

O If you are using Mac OS X, you need Mac OS X v10.2 or higher to use this
function.

ﬂ Configure the Locked Print in the printer driver's properties.
For details about configuring the printer drivers, see the corresponding Help
files.

ﬂ Start printing from the application's [Print] dialog box.
The Locked Print job is sent to the machine.

B on the machine's control panel, press the [ Printer] key to display the Printer
screen.

O press [Print Jobs].

PPaper Tray Status
TELD 2120 3120
HrOfline A4 A4 A3

Plob Lists & Error Log

Job Reset ‘ ‘ Print Jobs | | E

A list of print files stored in the machine appears.

B press [Locked Print Job List].
Print Jobs Exit

Select Jots)
S User D Date/Time  FileName Selected 0
1B 1236 | 08/23 20121 | seememennenx

bsPerUser D | [3@| 125 | 08/23 20119 | seesememeenenes

Complete List

& Locked Print Job List

9 Sanele Print lob Lst
(3 ol rint Jb List
53 Store Print Job List

Details 7

A list of Locked Print files stored in the machine appears.
Depending on the security settings, certain print jobs may not be displayed.
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E Select the file you want to print, and then press [Print].

Prnt Jobs et ]

Select jobts).

s User ID Date / Time _ File Name Selected: 1

@) 1236 | 08/23 20:21 | seesmmooonnnees | |_Select All kobs

lobsPerUser D | (@1 12384 | 08/25 20119 | seermmemsesmnrne Clear All
Complete List

9 Sanele Print Jo List

(34 Hold Print Job List Change Password

53 Stored Print Job List Print.

Details i Delete
150V 200
5 Tesst

The password screen appears.

ﬂ Enter the password using the number keys, and then press [OK].

@ Enter the password with the Number keys,
then press [OK].

Cancel oK

The print confirmation screen appears.

A confirmation screen will appear if the password is not entered correctly.
Press [Exit] to enter the password again.

If multiple print files are selected, the machine prints files that correspond to
the entered password. The number of files to be printed is displayed on the
confirmation screen.

If you forgot your password, ask your network administrator for help.

B Press [Yes].

The locked file is printed.
Press [No] to cancel printing.

& Note
O When printing is completed, the stored file will be deleted.

O To stop printing after printing has started, press [Exit] until the Printer
screen appears, and then press [Job Reset]. The file will be deleted.



Printing from the Print Job Screen

Deleting Locked Print files

0 press the [Printer] key to display the Printer screen.
EJ press [Print Jobs].

EJ press [Locked Print Job List].
A list of Locked Print files stored appears.
Depending on the security settings, certain print jobs may not be displayed.

ﬂ Select the file you want to delete, and then press [Delete]
The password screen is displayed.

B Enter the password using the number keys, and then press [OK].
The delete confirmation screen appears.

A confirmation screen will appear if the password is not entered correctly.
Press [Exit] to enter the password again.

If you forgot your password, ask your network administrator for help.

B Press [Yes].
The selected file is deleted.
If you do not want to delete the file, press [No].

@ Note

O If multiple print files are selected, the machine deletes files that correspond
to the entered password. The number of files to be deleted is displayed on
the confirmation screen.
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Hold Print

Use this function to temporarily hold a file in the machine, and print it from the
computer or the machine's control panel later.

ﬂlmportant
O A Hold Print file cannot be stored if:

¢ the total number of Sample Print, Locked Print, Hold Print, and Stored
Print files in the machine is over 100. (The maximum number varies de-
pending on the volume of data in files.)

¢ the file contains over 2,000 pages.
* sent or stored files in the machine contain over 10,000 pages in total.

& Note

O If a Hold Print file has not been stored properly, check the error log on the dis-
play panel.

O Even after you turn off the machine, stored documents in the machine re-
main. However, the [Auto Delete Temporary Print Jobs] or [Auto Delete Stored Print
Jobs] settings are applied first.

O If the application has a collate option, make sure it is not selected before send-
ing a print job. By default, Hold Print jobs are automatically collated by the
printer driver. If a collate option is selected from the application's Print dialog
box, more prints than intended may be produced.

3 For details about the [Auto Delete Temporary Print Jobs] and [Auto Delete Stored
Print Jobs], see “System Settings”, General Settings Guide.

AP Reference
For details about the error log on the display panel, see p.101 “Checking the
Error Log”.



Printing from the Print Job Screen

Printing a Hold Print file

The following procedure describes how to print a Hold Print file with the PCL
6/5e and the RPCS printer driver. For information about how to print a Hold
Print file with the PostScript 3 printer driver, see Postscript 3 Supplement in-
cluded as a PDF file in the supplied CD-ROM.

iﬁklmportant

O Applications with their own drivers, such as PageMaker, do not support this
function.

O If you are using Mac OS X, you need Mac OS X v10.2 or higher to use this
function.

ﬂ Configure Hold Print in the printer driver’s properties.
For details about configuring the printer drivers, see the relevant Help files.

ﬂ Click [Details...], and then enter a User ID in the [User ID:] box.

B Start printing from the application’s [Print] dialog box.
The Hold Print job is sent to the machine and stored.

O on the machine’s control panel, press the [Printer] key to display the print-
er screen.

B press [print Jobs].

MPaper Tray Status
TELD 21030
HrOfline A4 A4 A3

P lob Lists & Error Log

Joh Reset ‘ ‘ Print Jobs | | E

[3 press [Hold Print Job List].
Print Jobs. Exit

Select job(s).
All Jobs

Jobs Per User ID

Complete List
& Locked Print Job List
[ Sanple Print Job List

31 Hold Print b List

9 Store Print Job List

User ID Date / Time ~ File Name. Selected 0
1234 08/24 17:21 | New Wordoad Document
1234 08/24 17:21 | New Wordoad Documer
1234 08/24 17:19 | New Wordpad Document
1234 08/24 17:19 | New Wordpad Document

EY EY EY ES

Detalls 1”1

A list of a print files stored in the machine appears.
Depending on the security settings, certain print jobs may not be displayed.
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ﬂ Select the file you want to print, and press [Print].

Print Jobs. Exit
Select job(s).
A UserD  Date/Time FileName Selected: 1
B | 1234 | 08/24 17:21 | New Worcbad Document Select All Jobs
Jobs Per User ID BU | 1234 | 08/24 17:21 | New Horcbad Docunent Clear All
Br | 1234 | 08/24 17:19 | New Worcbad Docunent
CompleteList
BY | 1234 | 08/24 17:19 | New Horcbad Docunent
@ Locked Print ob List
(& Sanple Print lob List
(B ol Print Job List
3 Stored Print Jab List Print

Details i Delete
System Status.

The confirmation screen appears.

B press [es].
The Hold Print file is printed.
Press [No] to cancel printing.

& Note

O When printing is completed, the stored file is deleted.

O To stop printing after printing has started, press [Exit] until the Printer
screen appears, and then press [Job Reset]. The file will be deleted.

& Note

O For details about setting printer drivers, see the printer driver Help. You
can also print or delete a Hold Print file from Web Image Monitor. For de-
tails, see Web Image Monitor Help.

Deleting Hold Print files

0 press the [Printer] key to display the Printer screen.
B press [Print Jobs].

A list of print files stored in the machine appears.

EJ press [Hold Print Job List].
A list of a Hold Print files stored in the machine appears.
Depending on the security settings, certain print jobs may not be displayed.

ﬂ Select the file you want to delete, and then press [Delete]
The delete confirmation screen appears.

B Press [Yes] to delete the file.
The selected file is deleted.
If you do not want to delete the file, press [No].



Printing from the Print Job Screen

Stored Print

As print files are not deleted after printing is completed, sending the same print
file every time is not necessary, effective when printing same files repeatedly.

ﬂlmportant
O A Stored Print file cannot be stored if:

¢ the total number of Sample Print, Locked Print, Hold Print, and Stored
Print files in the machine is over 100. (The maximum number varies de-
pending on the volume of data in files.)

¢ the file contains over 1,000 pages.
* sent or stored files in the machine contain over 2,000 pages in total.

& Note

O If a Stored Print file has not been stored properly, check the error log on the
display panel.

O Even after you turn off the machine, stored documents remain. However, the
[Auto Delete Temporary Print Jobs] or [Auto Delete Stored Print Jobs] settings are
applied first.

O If the application has a collate option, make sure it is not selected before send-
ing a print job. By default, Stored Print jobs are automatically collated by the
printer driver. If a collate option is selected from the application's Print dialog
box, more prints than intended may be produced.

3 For details about the [Auto Delete Temporary Print Jobs] and [Auto Delete Stored
Print Jobs], see “System Settings”, General Settings Guide.

AP Reference
For details about the error log on the display panel, see p.101 “Checking the
Error Log”.
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Printing a Stored Print file

The following procedure describes how to print a Stored Print file with the PCL
6/5e and the RPCS printer driver. For information about how to print a Stored
Print file with the PostScript 3 printer driver, see Postscript 3 Supplement in-
cluded as a PDF file on the supplied CD-ROM.

iﬁklmportant
O Applications with their own drivers, such as PageMaker, do not support this
function.

O If you are using Mac OS X, you need Mac OS X v10.2 or higher to use this
function.

ﬂ Configure Stored Print in the printer driver’s properties.
You can select two ways for Stored Print:

e [Stored Print]
Stores the file in the printer and print it later using the display panel.

e [Store and Normal Print]
Prints the file at once and also stores the file in the machine.

For details about configuring the printer drivers, see the relevant Help files.

ﬂ Click [Details...], and then enter a User ID in the [User ID:] box.
You can also set a password. The same password must be entered when print-
ing or deleting.

B Start printing from the application’s [Print] dialog box.
The Stored Print job is sent to the machine and stored.

ﬂ On the machine’s control panel, press the [Printer] key to display the Print-
er screen.

B press [print Jobs].
| . g BPaper Tray Status
TELD 21030
M OFfline A4 A4 A3
Plob Lists & Error Log
Joh Reset ‘ ‘ Print Jobs || E




Printing from the Print Job Screen

[3 press [Stored Print Job List].

Prnt Jobs [ et

Select job(s).

All Jobs User ID Date / Time  File Name Selected: 0

2 1234 08/24 17:28 | New Wordpad Document ‘

dobs Per User ID D | 123 __| 08/24 17:27 | New Wordoad Document |

Comeeis S 1234 | 08/25 20:29 | New Horcbad Docunent |

Details i

A list of Stored Print files stored in the machine appears.

ﬂ Select the file you want to print, and press [Print].

Print Jobs. Exit

Select job(s).

All Jobs User ID Date / Time _ File Name Selected: 1
S 1234 08/26 17:28 New Horcbad Docunent | |_Select All kobs

JobsPerUser D | 571" 1236 | 08/24 17:27 | New Wordead Document Clear All
D | 1234 |08/25 20:29 | New Horcbad Docunent |
Complete List

(3 Fold Print Jb List Change Password
49 Store Print Job List Print.

Details 71 Delete
e shov 2006

The confirmation screen appears.

If you set a password in the printer driver, a password confirmation screen
appears. Enter the password.

If multiple print files are selected, the machine prints files that correspond to
the entered password and files that do not require a password. The number
of files to be printed is displayed on the confirmation screen.

If you forgot your password, ask your network administrator for help.

8 Enter the number of sets using the number keys.

@ Are you sure you want to print
the following?

User ID: 1234
File Name: Microsoft Word - Print_001.doc

The set aquantity can be changed.

_2 a-9»

You can enter up to 999 sets.
Press the [Clear/Stop ] key to correct any entry mistakes.

B press [ves).
The Stored Print file is printed.
Press [No] to cancel printing.
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@ Note

O When multiple print files are selected, the minimum number of set quan-
tity among all settings is applied.

O When the number of set quantity is changed, the changed quantity is ap-
plied to all selected print files.

O To stop printing after printing has started, press [Exit] until the Printer
screen appears, and then press [Job Reset]. A Stored Print file is not deleted
even if [Job Reset] is pressed.

O The Stored Print file that sent to the machine is not deleted unless you de-
lete a file or select [Auto Delete Stored Print Jobs] (see “Printer Features”, Gen-
eral Settings Guide).

O For details about setting printer drivers, see the printer driver Help. You
can also print or delete a Stored Print file from Web Image Monitor. For de-
tails, see Web Image Monitor Help.

Deleting Stored Print files

0 press the [Printer] key to display the Printer screen.

B press [Print Jobs].
A list of print files stored in the machine appears.

B Press [Stored Print Job List].
A list of Stored Print files stored in the machine appears.
Depending on the security settings, certain print jobs may not be displayed.

ﬂ Select the file you want to delete, and press [Delete].
The delete confirmation screen appears.
If you set the password in the printer driver, enter the password to delete.

If multiple print files are selected, and some of these require a password, the
machine deletes files that correspond to the entered password and files that
do not require a password. The number of files to be deleted is displayed on
the confirmation screen.

If you forgot your password, ask your network administrator for help.

B Press [Yes] to delete the file.
The selected file is deleted.
If you do not want to delete the file, press [No].



Printing from the Jobs Per User ID Screen

Printing from the Jobs Per User ID Screen

This describes how to print the files saved in the machine from the User ID
screen.

Printing the Selected Print Job

ﬂ Press the [ Printer] key.
The Printer screen appears.

ﬂ On the Printer screen, press [Print Jobs].

- WPaper Tray Status
10200340
HrOffline A4 A4 A3

B Joh Lists & Error Log

Job Reset ‘ ‘ Print Jobs | | E

A list of user IDs whose files are stored in the machine appears.

B Press the user ID whose file you want to print.

Print Jobs Exit
Select User D
AlLjobs for the selected user ID will be printed.
Clear Complete List
o | List Per User ID

Print All Jobs

7 Back

You cannot select multiple user IDs at the same time.
Press [4Previous] or [YNext] to scroll through the list.
Press [Clear] to cancel a selection.

Q3
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O press [List Per User ID].

Exit

List Per User 1D

The print job list of the selected user ID appears.
B Select the desired print jobs.

Print Jobs Exit

Select job(s).

All Jobs User ID Date / Time  File Name Selected:

3888 D 8888 | 08/24 17:34  New orcbad Docunent |

[ Jobs e er D Bt 6888 | 08/24 17:34  New Horcbad Document |
1B 8888 | 08/24 17:33 | wemmmmnnnnnnnnes ‘
6868 | 08/264 17:52  New Horcbad Document |

| CompleteList
& Locked Print Job List
(39 Sample Print Job List
[1 Hold Print Job List
4 Stored Print Job List

Details ”n

To cancel a selection, press the highlighted print job again. To clear all selec-
tions, press [Clear All].

B Press [Print].

The confirmation screen appears.

U press [es].
The selected files are printed.



Printing from the Jobs Per User ID Screen

Printing All Print Jobs

ﬂ Press the [Printer] key.

The Printer screen appears.

ﬂ On the Printer screen, press [Print Jobs].

BPaper Tray Status

TELD 21030

Plob Lists & Error Log
Joh Reset ‘ ‘ Print Jobs || E

System Statu

A list of user IDs whose files are stored in the machine appears.

B Press the user ID whose file you want to print.

——
Print Jobs Exit

Select User ID
All jobs for the selected user ID will be printed.

Clear Commlete List
123 | esse List Per User ID

Print All Jobs

7

Back

You cannot select multiple user IDs at the same time.

Press [4Previous] or [YNext] to scroll through the list.
Press [Clear] to cancel a selection.

O press [Print All Jobs].

List Per User 1D

Print ALL Jobs

3 . 15 OV 2008
System Status .

If the selected user ID has multiple types of print jobs, the selection screen of
the print job type appears.
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B Select the desired print job type, and then press [OK].

@ To print all jobs for the selected user ID,
select the job type(s), then press [OK].

Locked Print Jobs. [ Samole frint Jobs.

HoldPrint kobs | [ Stored Print Jobs

The confirmation screen appears.

The confirmation screen does not appear if the selected ID has only one type
of print jobs.

(3 press [ves).
The selected files are printed.

4 Note

O After printing is completed, Sample Print, Locked Print, and Hold Print
files are deleted.

O You cannot select a print job that is not stored under the selected user ID.

O If you select multiple Sample Print Files and do not specify the number of
sets on the confirmation screen, one set less than the number specified on
the computer is printed for every selected document. If the number of sets
specified on the computer is “1”, one set each is printed for every docu-
ment.

O If you select Stored Print, the number you set on the confirmation screen is
applied to all files of the selected print job type. If you do not set a quantity,
the minimum number is applied to all files.

O If you select Locked Print, enter the correct password. If there are multiple
passwords, the machine prints only files that correspond to the entered
password.

O If you select Stored Print files, and some of these require a password, the
machine prints files that correspond to the entered password and files that
do not require a password.



Form Feed

Form Feed

This section gives instructions for operating the machine when there is no tray for
the selected paper size or type, or when paper loaded in the machine has run out.

ﬁklmportant
O The tray cannot be changed if the following functions are set:

e Staple

¢ Punch

¢ Duplex Print to a tray that does not support duplex printing
¢ Cover Sheet

* Front or Back Covers

* Slip Sheet

¢ Chaptering

* Z-fold

@ Note

O If form feed is selected for a tray with the following settings, you can change
the tray by canceling the settings:

e Staple
¢ Punch
* Duplex Print to a tray that does not support duplex printing

O If Auto Continue is selected, form fed paper is printed after a set interval. See
“System”, General Settings Guide.

Printing from a Selected Tray

If the machine does not have a tray for the selected paper size or paper type, or
if the selected paper loaded in the machine has run out, a caution message ap-
pears. If this message appears, do the following procedure.

0 press the [ Printer] key.

g Select the tray for form feed from those that appear on the display panel.

If you want to print after adding paper to the tray, select the tray after loading
the correct paper.

B Press [OK].
The machine prints using the selected tray.

@ Note

O If a tray with a smaller paper size is selected, the print job may be cut short,
or other problems may occur.
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Canceling a Print Job

Follow the procedure below for canceling the print job if the message prompting
form feed appears.

ﬂ Press the [Printer] key.
The Printer screen appears.

B Press [Job Reset].
Delete the stored print jobs, and then cancel form feed.

8 Press [Reset the Job] to cancel the current print job, or [Reset All Jobs] to cancel
all jobs.

A confirmation message appears.

ﬂ Press [Yes] to cancel the print job.
Press [No] to return to the previous display.

& Note
O To resume printing print jobs, press [Resume Printing]

O If the machine is shared by multiple computers, be careful not to acciden-
tally cancel someone else's print job.

O Under Windows, if the machine is connected to the computer using a par-
allel cable, sent print jobs may be canceled if [Reset All Jobs] is pressed
while “Waiting...” is on the display panel. After the interval set in [I/O Time-
out] in Printer Features has passed, the next print job can be sent. A print
job sent from a different client computer will not be canceled in this case.

O You cannot stop printing data that has already been processed. For this
reason, printing may continue for a few pages after you press [Job Reset].

O A print job containing a large volume of data may take considerable time
to stop.

A Reference
For details, see p.99 “Canceling a Print Job”.



Canceling a Print Job

Canceling a Print Job

This section gives instruction to stop printing from the computer or the display panel.

Canceling a Print Job Using the Control Panel

ﬂ Press the [ Printer] key.
The Printer screen appears.

E press [Job Reset].

E B WPaper Tray Status

: TELI D 210 03 10
M Offline A4 A4 A3

P oh Lists & Error Log
Job Reset ‘ ‘ Print Jobs || E

B Press [Reset the Job] or [Reset All Jobs].

@ [Job Reset] has been pressed.
The following job has been suspended.

Narme:
User ID: 8888
File Name: New Wordpad Document

| Reset the Job ][ Reset ALL Jobs ] [Resume Printing]

* [Reset the Job]: cancels the print job currently being processed.
* [Reset All Jobs]: cancels all jobs in the print queue.

* [Resume Printing]: resumes printing print jobs.

A confirmation message appears.

ﬂ Press [Yes] to cancel the print job.
Press [No] to return to the previous display.
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Windows - Canceling a Print Job from the computer

You can cancel a print job from the computer if transferring print jobs is not completed.

ﬂ Double-click the printer icon on the Windows task tray.

A window appears, showing all print jobs currently queued for printing.
Check the current status of the job you want to cancel.

ﬂ Select the name of the job you want to cancel.

8 On the [Document] menu, click [Cancel].

O press the [ Printer] key on the machine's control panel.

@ Note

0

0

If the machine is shared by multiple computers, be careful not to acciden-
tally cancel someone else's print job.

If the machine is connected to the computer using a parallel cable, sent
print jobs may be canceled if [Reset All Jobs] is pressed while “Waiting...”
is on the display panel. After the interval set in [I/O Timeout] in Printer Fea-
tures has passed, the next print job can be sent. A print job sent from a dif-
ferent client computer will not be canceled in this case.

Under Windows XP/Vista or Windows Server 2003/2003 R2, click [Cancel]
on the [Document] menu.

Under Windows 2000/ Vista, you can also open the print job queue win-
dow by double-clicking the machine icon in the [Printers] machine window
(the [Printers and Faxes] window under Windows XP and Windows Server
2003/2003 R2).

You cannot stop printing data that has already been processed. For this
reason, printing may continue for a few pages after you press [Job Reset].

A print job containing a large volume of data may take considerable time
to stop.



Checking the Error Log

Checking the Error Log

If files could not be stored due to printing errors, identify the cause of the errors
by checking the error log on the control panel.

ﬂlmportant

O The most recent 50 errors are stored in the error log. If a new error is added
when there are 50 errors already stored, the oldest error is deleted. However,
if the oldest error belongs to one of the following print jobs, it is not deleted.
The error is stored separately until the number of those errors reaches 30. You
can check any of these print jobs for error log information.

¢ Sample Print
e Locked Print
e Hold Print

e Stored Print

O If the main power switch is turned off, the error log is deleted.

ﬂ Press the [ Printer] key.
The Printer screen appears.

g Press [Error Log].

PPaper Tray Status

TEU20 0300 =W
A4 A4 A3 A4

P Job Lists & Error Log

Print Jobs H Error Log

System Status

An error log list appears.
Depending on the security settings, certain errors may not be displayed.

8 Press the desired job list.
You can select job list from [Complete List], [Locked Print Job List], [Sample Print
Job List], [Hold Print Job List], or [Stored Print Job List].

ﬂ Select the print file you want to check, and then press [Details].
A detailed error log appears.
Press [APrevious] or [Y Next] to scroll the error files.

& Note
O Press [Exit] after checking the log.
O Press [Back to List] to return to the error log list.

O To print files that appear in the error log, resend them after stored files
have been printed or deleted.
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Spool Printing

Spool Printing allows print jobs transferred from a computer to be temporarily
stored, and then prints them after they are transferred. This shortens printing
time as it maximizes printer efficiency.

ﬂlmportant

0

During Spool Printing, the hard disk is accessed and the Data In indicator
blinks. Turning off the computer or machine during Spool Printing can dam-
age the hard disk. Also, if the computer or machine is turned off during Spool
Printing, spooled jobs will be deleted. Therefore, do not turn the power of the
computer or machine off during Spool Printing.

If data is sent to the machine using other protocols besides diprint, lpr, ipp,
ftp, sftp, and smb, Spool Printing cannot be performed.

Setting Spool Printing
Spool Printing can be set using telnet or Web Image Monitor.

* Using Web Image Monitor
See Network Guide or Help for more information.

¢ Using telnet
Type in “spoolsw spool on” to set Spool Printing.
See Network Guide for more information about telnet.

Viewing a list of spool jobs on the display panel

If Spool Printing is set, a list of spooled jobs can be viewed on the display pan-
el screen.

Press the [ Printer] key, and then press [Spooling Job List]. A list of spooled jobs
appears.

¢ Deleting jobs
Select files to be deleted, and then press [Delete].

Viewing/Deleting spool jobs in Web Image Monitor

Start Web Image Monitor and enter the machine's IP address in the address
bar. This displays the top page.

For more information, see Network Guide.

& Note

)
)
)
a

0

Up to a maximum of 150 jobs at once can be spool printed.
If Spool Printing is not set, you cannot select [Spooling Job List].
Printing the first page with Spool Printing will be slow.

The computer requires less print processing time when large amounts of data
are spooled.

Stored spool jobs can be viewed or deleted using Web Image Monitor.



User Defined Pages

User Defined Pages

Using this function, you can specify the page numbers for each input tray.

ﬂlmportant
O This function is available with the PCL 6/5e printer driver only.

O If [Document Server] is selected under [Job Type:], User Defined Page cannot be
used.

3 If [User Defined Pages] is selected under [Paper Selection:] on [Paper] tab, [Lay-
out:] cannot be selected.

AEV044S

& Note
O For printing methods, see the printer driver Help.
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Printing with the Finisher

You can collate, staple, or punch holes in printed paper by installing the optional
finisher. Make sure you read the following precautions when using the optional
finisher.

ﬂlmportant

O Make option settings for the machine using the printer driver when bidirec-
tional communication is disabled.

O Be sure to set the paper size and paper orientation in the printer driver when
using duplex printing, booklet printing, combined printing (layout), staple,
punch, and Z-fold functions.

O The machine can have only one of the following installed at any one time:

3,000Sheet-50Sheet Staple Finisher, 3,000Sheet-100Sheet Staple Finisher,
Booklet Finisher, Shift Tray, or Copy Tray.

O The optional Mailbox can be installed with the 3,000Sheet-50Sheet Staple Fin-
isher or Booklet Finisher. The optional Mailbox cannot be installed if the
3,000Sheet-100Sheet Staple Finisher, Shift Tray, or Copy Tray is installed.

@ Note

O Depending on the application, print settings may not be enabled and printed
output may not be as expected.

O When setting Staple or Collate in the printer driver, make sure that the Collate
check box is cleared in the application's [Print] dialog box. If Collate is enabled
in the application, printing will not be as intended.

O When printing restarts after removing jammed paper, the printing position
may be different, depending on the location of the jam.

¢ If the paper jam occurred in the optional finisher, printing will restart from
the top page of the data currently being printed, or from the page where
the paper jam occurred.

¢ If the paper jam occurred in the machine, printing will restart from the
page where the paper jam occurred.

¢ Even if the paper jam occurred in the machine, the error will not be cleared
unless the cover of the finisher is opened and closed.

O For details about duplex printing, booklet printing, or combined printing
(layout), see the printer driver Help.

O For information about optional finishers, see General Settings Guide.
O To remove paper misfeeds, see Trouble Shooting.



Printing with the Finisher

Staple

With the optional 3,000Sheet-50Sheet Staple Finisher, 3,000Sheet-100Sheet Sta-
ple Finisher or Booklet Finisher installed, sets can be stapled individually when
printing multiple sets.

Staple position

The specified staple position varies depending on paper size, type, quantity and
feed orientation. The following table shows staple positions:

Paper Staple Position
Orientation | Print Data
on the Direction 3,000Sheet-50Sheet / Booklet 3,000Sheet-100Sheet
Machine Staple Finisher Finisher Staple Finisher
o] | ] wga | o]
i
L
_ || PEEE | OEEEE
o a 3
Landscape E E
ANWO001S
& Note

O Stapling might not be in the specified position if combine (layout) and duplex
printing are both selected. After setting the staple position, use the printer
driver's preview icon to check the position before printing.

O For paper sizes and maximum numbers of sheets available for stapling, see
“Specifications”, General Settings Guide.

O For printing methods, see the printer driver Help.
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Stapling precautions

ﬂlmportant

0

Stapling can be done only with the optional finisher installed.

+ Staple printing will be canceled under the following conditions:

¢ If the number of pages exceeds maximum for stapling.

¢ If a paper size that cannot be stapled is selected.

 If a paper type that cannot be stapled is selected.

* If positions other than those fixed for stapling are specified.

* If there are inconsistencies between the orientation in the duplex mode and
the staple position.

e If there are inconsistencies between the orientation in letterhead mode and
the staple position.

* If paper sizes are mixed when a different paper size is specified during a
print job.
* When feeding paper from the bypass tray.

* When staples have run out and Auto Continue is set (Printing will contin-
ue without stapling after the message has been displayed).

* When only 1 page is printed.
* When staples have run out.

@ Note

)
a

)
a

0

)
)
a

0

When the stapling is cancelled, “BD: Staple has been cancelled.” appears.

If Staple or Shift Collate is selected with the optional 3,000Sheet-50Sheet Staple
Finisher, 3,000Sheet-100Sheet Staple Finisher and Booklet Finisher installed,
the paper will be output to the finisher shift tray irrespective of the setting.

When printing on letterhead, stapling may not be at the specified position.

If you cannot make staple settings even with 3,000Sheet-50Sheet Staple Fin-
isher, 3,000Sheet-100Sheet Staple Finisher, and Booklet Finisher installed, op-
tions may not be set correctly in the printer driver. Correct option settings in
the printer driver. For details, see the printer driver Help.

When the finisher is being used for another function's job (for example, a copy
job), printing will start after that job ends.

Be sure to set paper size and orientation in the printer driver when stapling.
When duplex printing is selected, adjust staple positions to the binding orientation.

Depending on the software you are using, print settings may not be saved
and the printed result may not be as expected.

When setting Staple in the printer driver settings, make sure that a collate op-
tion is not selected in the print settings of the application. If a collate option is
selected in the application, printing will not be as intended.



Printing with the Finisher

Punch

With the optional 3,000Sheet-50Sheet Staple Finisher, 3,000Sheet-100Sheet Staple
Finisher, or Booklet Finisher installed, holes can be punched into printed output.

Punch position

The specified punch position varies depending on paper feed and print data ori-
entation. The following table shows punch positions:

Paper Orientation | Print Data Punch Position
on the Machine | Direction 2 holes 3 holes 4 holes
. L . o : :
D Portrait .R R. :R R: :R R:
3 3 o o o ee e e
Landscape R R R
e o L X ] (XX X]
Portrait R R R
.R ‘R :R
Landscape o < 3
R. R: R:

& Note

O Punch positions will vary slightly from page to page as holes are punched
into each sheet individually.

O For information about paper sizes that can be punched, see “Specifications”,
General Settings Guide.

O For printing methods, see the printer driver Help.
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Punching precautions

Follow these precautions when using the punch function.

ﬂlmportant

O This function is possible only when the optional 3,000Sheet-50Sheet Staple
Finisher, 3,000Sheet-100Sheet Staple Finisher, or both the Mailbox and Punch
Kit is installed.

% Punch printing will be canceled under the following conditions:

When a paper type that cannot be punched is selected.
When a paper size that cannot be punched is selected.
If positions other than those fixed for punching are specified.

If there are inconsistencies between the orientation in duplex mode and the
punch position.

If there are inconsistencies between the orientation in letterhead mode and
the punch position.

When feeding paper from the bypass tray.

When the punch receptacle has become full and Auto Continue is set
(Printing will continue without punching after the message appears).

If there are inconsistencies between the staple position and the punch po-
sition, when using with staple function.

& Note
O When the punching is cancelled, “BE: Punch has been cancelled.” appears.

O Punching might not be in the specified position when printing on letterhead paper.

O If you cannot make punch settings even with the optional finisher installed,
options may not be set correctly in the printer driver. Correct option settings
in the printer driver. For details, see the printer driver Help.

O When duplex print is selected, adjust the punch position to the binding direction.

O Be sure to set the punch position the same as the staple position when using
it with the staple function.

O Be sure to set paper size and orientation in the printer driver when punching.

O Depending on the application, print settings may not be enabled and printed
output may not be as expected.

O When setting Punch in the printer driver settings, make sure that a collate op-
tion is not selected in the print settings of the application.

O If a collate option is selected in the application, printing will not be as intended.

O The punch function and Z-fold function cannot be selected concurrently.



Printing with the Finisher

Collate

When printing multiple documents such as handouts for meetings, you can sep-
arate sets into order. This function is known as “Collate”. Collate stores data
transmitted from a computer to the printer memory or hard disk drive. The fol-
lowing are the three types of Collate:

ﬁ*lmportant
O If Auto Continue occurs on the first set, Collate will be canceled.

O If forced printing occurs on the first set, Collate will be canceled.

O When setting Collate in the printer driver settings, make sure that a collate
option is not selected in the application's print settings. If a collate option is
selected, printing will not be as intended.

& Note
O Set Collate and Rotating collate when using the RPCS printer driver.

O Follow the procedure below when using the printer driver other than the
RPCS:

¢ Set Collate and Rotating Collate in the printer driver.

¢ If you cannot make Shift Collate even with the optional finisher installed,
options may not be set up correctly in the printer driver. Correct the printer
driver's option settings.

* For details, see the printer driver Help.

Collate

Printed output is assembled as sets in sequential order.

o>
123 123 123 123

AEU016S
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Rotating Collate

Every other print set is rotated by 90 degrees.

T

ﬁ*lmportant

O The Rotating Collate function requires two paper trays containing same size
paper but in different orientations.

O If the output tray has shift function, Shift Collate will be applied even if Ro-
tating Collate is selected.
< When Rotate Collate is cancelled

If the following functions are selected, Collate or Shift Collate will be applied
even if Rotating Collate is selected:

* When combined with staple function.

¢ When combined with punch function.

* When combined with z-fold function.

* If jobs containing pages of various sizes are set.
¢ When output tray is specified.

¢ When combined with covers function.

¢ When combined with slip sheet function.

* When combined with chaptering function.

* When combined with tab sheet function.

* If custom size paper is set.

& Note

O When Rotating Collate has been selected, printing speed will be slower than
with other collate functions.

AEU017S

Shift Collate

The optional finisher is required for this function.

The finisher shift tray moves backward or forward when a job or set is output,
causing the next to shift, so you can separate them.

1- ¢

AEU018S




Covers

Covers

Using this function, you can insert cover and back sheets fed from a different
tray to that of the main paper, and print on them.

*@*Important
O To use this function, Collate must be set. Rotating Collate cannot be set.

O The cover sheets should be the same size and orientation as the body of the
paper.

% Cover sheet
Prints the first page of the document on the sheet for the cover page.

* Print on one side
Prints on one side of the cover sheet only, even when duplex printing is se-

AEV016S

* Print on both sides
Prints on both sides of the cover sheet when duplex printing is selected.

* Front cover printed on both sides

oo

1

AEV017S

* Front cover printed on one side

Togip

2
1 1

AEV032S
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e Blank
¢ When printing one side

W-gl

2 1

1

AEV018S

* When printing both sides

Tgip

2

1

AEV033S
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Covers

++ Back cover
Prints the last page of the document as the back cover pages.
* Print on one side

Prints on one side of the cover sheets only, even when duplex printing is
selected.

* Back cover page face inside

T

12 112

AMT202S

* Back cover page face outside

e TP

12 1

AMT207S

¢ Print on both sides
Prints on both sides of the cover sheets when duplex printing is selected.

¢ Back cover page face inside, and the number of pages is odd

Wer b

1 2

AMT203S

* Back cover page face outside, and the number of pages is odd

T =7

AMT204S

(&
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* Back cover page face inside, and the number of pages is even

W

AMT205S8

* Back cover page face outside, and the number of pages is even

JIES

e Blank
* When printing one side

+

g

AMT206S

™~

AEV040S

¢ When printing both sides

=

AEV041S

& Note

O If “Auto Tray Select” is set as the paper feed tray for the body paper, the paper
will be delivered from a tray containing paper in the [J orientation. There-
fore, if the cover paper is set to the [’ orientation, the orientation of cover and
body will be different.

O For printing methods, see the printer driver Help.
114



Chaptering

Chaptering

The specified page is printed on the same side as the first page, like a book. Also,
you can insert chapter slip sheets before specified pages, and select whether or
not to print on the slip sheets.

No slip sheets

The specified page is always printed on the same side as the first page.

97

AJO025S

& Note
O This function is only valid with duplex printing.

O Up to 100 pages can be specified as the front pages of chapters using the print-
er driver.

O This function can be used together with combine (layout) printing.
O For printing methods, see the printer driver Help.
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Inserting chapter slip sheets

Insert chapter slip sheets before the specified page.

® Print
Prints on the chapter slip sheets. When duplex printing is selected, both sides
of the slip sheets are printed on.

ik

AJO023S

1k 4

AJO024S

4 Note

O Up to 100 pages can be specified as the front pages of chapters using the print-
er driver.

O The slip sheet should be the same size and orientation as the body of the paper.

O If “Auto Tray Select” has been set as the paper feed tray for the body paper,
the paper will be delivered from a tray containing paper in the [,) orientation.
Therefore, when the cover paper has been set to the LY orientation, the orien-
tation of the output cover paper and body paper will be different.

O The same paper feed tray cannot be set for the body of the document and the
slip sheet.

O For printing methods, see the printer driver Help.
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Slip Sheet

Slip Sheet

% Inserting a slip sheet between each page

-t

-

AEU023S

% Inserting a slip sheet between OHP transparencies

e Print
HE
10 = (2
e Blank

,_|:
)

AEU024S

& Note

O Collate cannot be set when using slip sheets.

O When the duplex printing or cover printing is set, you cannot insert slip sheets.
O The slip sheet should be the same size and orientation as the main paper.

O If “Auto Tray Select” has been set as the paper feed tray for the body paper,
the paper will be delivered from a tray containing paper in [ orientation.
Therefore, when the cover paper has been set to [’ orientation, the orienta-
tion of the output cover paper and body paper will be different.

O The same paper feed tray cannot be set for the main paper and slip sheets.
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Tab Sheet

Prints on tab sheets.

m>
o>,

&>

GCPY025E

ﬂlmportant

O Make sure to install the optional tab sheet holder when setting tab sheets.
Contact your service representative regarding the optional tab sheet holder
installation.

O Only tab sheets with the tab on the right (at the top part of the paper) can be
printed on.

@ Note

O Make sure to check the position of the tab beforehand, so that images to be
printed do not come out slanted. If there are any letters in a position where
the tab is not present, toner may dirty the back of the paper.

O If there are any inconsistencies between the position of the tab, the staple and
the punch hole, the tab position will be prioritized.

O For information about tab sheets size that can be printed, see the “General Set-
tings Guide”.

O For printing method, see the printer driver Help.



Z-fold

Z-fold

You can Z-fold prints when the optional Z-folding unit and the optional
3,000Sheet-100Sheet Staple Finisher or Booklet Finisher are attached.

Folding Positions

When Z-folding, select the folding positions for the front page using the printer
driver.

The relationship between the size of the front page and that of subsequent pages
determines whether the subsequent pages can be Z-folded.

Feed Front page
direction | priy girection Folding position™ Result
. A .
Right fold B | Z-fold not possible
Cc
A
(B: Bottom fold Z-fold possible
A
Left fold B | Z-fold not possible
) -
Right fold ‘ Z-fold possible
ABC Bottom fold ABC| Z-fold not possible
Left fold i Z-fold possible

AEWO009S

Subsequent pages

Paper size Result
Larger than front page F—‘ Z-fold possible
Smaller than front page D Z-fold not possible

AEWO010S

"1 Select the folding position according to the print direction.
"2 If the size of the paper is the same as that of the front page, the paper can be Z-folded
only if the front page can be Z-folded.
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Notes on the Z-fold Function

Follow these precautions when using the Z-fold function.

+ Z-folding will be canceled under the following conditions:
¢ When the Z-fold function is not supported for the selected paper type

¢ The Z-fold function is not supported for OHP transparencies, labels, thick
paper, translucent paper, and tab stock paper.

¢ When form feeding is used

* When the paper is fed from the optional interposer tray

¢ The rotating collate and auto tray switching cannot be used when Z-folding.
* When using Booklet Finisher.

& Note
3 You can Z-fold with A3, A4, B4, 11”x17”,8 1/,”x11”, and 8 1 /,”x14” paper.
O Z-folded paper can be stapled.

O When stapling Z-folded paper, fewer sheets than normal can be stapled to-
gether. This is because a single Z-folded sheet is equivalent to 10 non-Z-fold-
ed sheets.

O The Z-fold function and punch function cannot be used together. If the Z-fold
function is used, punch function settings are canceled.

The output has the following appearance:

Front page, Subsequent pages Right fold Bottom fold Left fold
A Allo Allo
& |asc g 94 3
C K HIE:
A4 A4

QO

ABC| |ABC 3| @ E c

A4 | |22 d
A4 A4
A A A
B/ |ABC B||A 0 B C
Cc Cc Cc
A4 A3

ABC|| [A]

wilac] | B |0 | BE
recl[r] | (]R8 (=] | [
g 8[R GH | BIR

A4 A5

ANWO013S
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4. Saving and Printing Using

the Document Server

Accessing the Document Server

The Document Server enables you to store documents on the machine's hard
disk, allowing you to edit and print as you, and when you, want.

ﬁlmportant
O Applications with their own drivers, such as PageMaker, do not support this
function.

& Note
O When you use the Document Server, the following functions can be selected
using the machine's control panel:

* Copies

e Collate

* Duplex

e Staple

Z-fold

Paper selection: Paper source tray, paper type, paper output tray.

* Functions related to paper selection: Cover Sheet, Slip Sheet.

O The above items are dimmed, so you cannot set them from the printer prop-
erties dialog box when the Document Server is selected.

O You must enter a user ID, using up to eight alphanumeric characters.

a

You should enter a Password and File Name to distinguish the job from others.

O Up to 3,000 files can be stored in the Document Server. No new files can be
stored after 3,000 is reached. Even if less than 3,000 files are stored, new files
cannot be stored when

* a file to be stored contains more than 2,000 pages,
¢ the total number of pages contained in files stored exceeds 10,000,
e the hard disk is full.

O The Document Server also stores files scanned using the Automatic Docu-
ment Feeder (ADF) or exposure glass. You should delete unnecessary stored
files once in a while so as not to exceed the capacity of the hard disk. For de-
tails about deleting stored files, see General Settings Guide.

O When using the hard disk for functions other than those of Document Server,
you may not be able to store new files in the Document Server, even if there
are less than 3,000 files stored.

O For more information about Document Server functions, see General Settings
Guide.

O For information about how to access Document Server from a client, see the

inter driver Help.
printer driver Help 191
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5. The Functions and Settings

of the Machine

Mainframe

Network Guide, PostScript 3 Supplement, and UNIX Supplement cover all mod-
els, and therefore contain all the functions and settings. This chapter describes
the functions and setting items used for configuring the model you are using.

@ Note

O For details about functions and setting items, see Network Guide, PostScript
3 Supplement and UNIX Supplement.

Functions

The following functions are available with the machine:
* Copy

¢ Printer

e Scanner

e Facsimile

* Document Server

@ Note

O The machine must be equipped with the Printer /Scanner Unit in order to use
the printer or scanner function.

Interface

The following interfaces are available with the machine:
e Ethernet (100BASE-TX/10BASE-T)

e USB (2.0)

o IEEE 1284 (Parallel) (Optional)

» JEEE 802.11b (Wireless LAN) (Optional)

¢ Bluetooth (Optional)

¢ Gigabit Ethernet (1000BASE-T) (Optional)

@ Note

3 To use the IEEE 1284, IEEE 802.11b (wireless LAN), Bluetooth or Ethernet
(Optional) interface, the machine must be equipped with the corresponding
unit for that interface.

3 You cannot have the IEEE 1284, IEEE 802.11b (wireless LAN), and Bluetooth
interface on the machine at the same time.

O You cannot have the standard Ethernet and the optional Ethernet interface on
the machine at the same time.
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List of the Setting ltems

Web Image Monitor

The following tables show Web Image Monitor items that can be viewed or mod-
ified depending on the selected mode on the Web browser.

Select one of the following modes to log on Web Image Monitor:
¢ User mode: log on as a user

¢ Administrator mode: log on as an administrator

% Home
e Status
Menu User mode Administrator mode
Toner Read Read
Input Tray Read Read
Output Tray Read Read
¢ Configuration
Menu User mode Administrator mode
Function Read Read
System Read Read
Version Read Read
Printer Language Read Read
e Counter
Menu User mode Administrator mode
Copier Read Read
Printer Read Read
Fax Read Read
Send/TX Total Read Read
Fax Transmission Read Read
Scanner Send Read Read
Other Function(s) Read Read
¢ Inquiry
Menu User mode Administrator mode
Machine Maintenance/Re- | Read Read
pair
Sales Representative Read Read




List of the Setting Items

< Document Server

e Document Server

User mode Administrator mode

Read /Modify Read /Modify

« Fax Received File

e Fax Received File

User mode Administrator mode

Read /Modify None

«» Printer: Print Jobs
e Print Job List

User mode Administrator mode
Read /Modify Read /Modify
% Job
e Job List
Menu User mode Administrator mode
Current/Waiting Jobs Read Read
Job History Read Read
e Printer
Menu User mode Administrator mode
Job History Read Read
Error Log Read Read
¢ Fax History
Menu User mode Administrator mode
Transmission Read Read
Reception Read Read
LAN-Fax Read Read
® Document Server
Menu User mode Administrator mode
Print Job History Read Read
Scanner Remote Send His- | Read Read
tory
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«» Address Book
e Address List

Menu User mode Administrator mode
Address Book None Read /Modify
% Configuration
* Device Settings
Menu User mode Administrator mode
System Read Read/Modify
Paper Read Read/Modify
Date/Time Read Read/Modify
Timer Read Read/Modify
Logs None Read/Modify
E-mail Read Read/Modify
Auto E-mail Notification None Read /Modify
On-demand E-mail Notifi- | None Read /Modify
cation
File Transfer None Read /Modify
User Authentication Man- | None Read/Modify
agement
Administrator Authentica- | None Read/Modify
tion Management
Program/Change Adminis- | None Read/Modify
trator
LDAP Server None Read /Modify
Printer
Menu User mode Administrator mode
Basic Settings Read Read /Modify
Tray Parameters (PCL) None Read /Modify
Tray Parameters (PS) None Read /Modify
PDF Temporary Password | Modify None
PDF Group Password None Modify
PDF Fixed Password None Modify




List of the Setting Items

¢ Fax
Menu User mode Administrator mode
Environment Settings None Read /Modify
Send / Reception Settings | None Read /Modify
IP-Fax Settings None Read /Modify
IP-Fax Gateway Settings None Read /Modify
Parameter Settings None Read /Modify
* Interface
Menu User mode Administrator mode
Interface Settings Read Read/Modify
* Network
Menu User mode Administrator mode
IPv4 Read Read/Modify
IPv6 Read Read/Modify
NetWare Read Read /Modify
AppleTalk Read Read /Modify
SMB Read Read /Modify
SNMP None Read /Modify
SNMPv3 None Read /Modify
SSDP None Read /Modify
Bonjour Read Read /Modify
System Log Read Read
* Security
Menu User mode Administrator mode
Network Security None Read /Modify
Access Control None Read /Modify
IPP Authentication None Read/Modify
SSL/TLS None Read /Modify
ssh None Read /Modify
Site Certificate None Read /Modify
Device Certificate None Read /Modify
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e RC Gate
Menu User mode Administrator mode
Setup RC Gate None Read /Modify
Update RC Gate Firmware | None Read /Modify
RC Gate Proxy Server None Read /Modify
* Webpage
Menu User mode Administrator mode
Webpage Read /Modify Read /Modify

¢ Extended Feature Settings

Menu User mode Administrator mode

Startup Setting None Read/Modify
Extended Feature Info None Read

Install None Read /Modify
Uninstall None Read /Modify
Change Allocation None Read

Administrator Tools None Read/Modify
Copy Extended Features None Read /Modify
Copy Card Save Data None Read /Modify

& Note
O Some items are not displayed depending on the security settings.

telnet

The following telnet can be used with the machine:

access, appletalk, authfree, autonet, bonjour (rendezvous), btconfig, device-
name, dhcp, diprint, dns, domainname, help, hostname, ifconfig, info, ipp, ipv6,
lpr, netware, passwd, prnlog, route, set, show, slp, smb, snmp, sntp, spoolsw,
sprint, ssdp, ssh, status, syslog, upnp, web, wiconfig, wins



List of the Setting Items

Settings that can be used with PostScript 3

The following PostScript 3 settings can be used with the machine:

& Note

O Depending on a type of printer drivers, different items may be displayed.

Settings Selectable Items

Collate: Off, On

Dithering;: Auto, Photographic, Text, User Setting

Duplex: Off, Open to Left, Open to Top

Fit to Print Size: Prompt User, Nearest Size and Scale, Nearest Size and Crop

Image Smoothing:

Off, On, Auto, Less than 90 ppi, Less than 150 ppi, Less than
200 ppi, Less than 300 ppi

Input Tray: AutoSelect Tray, Bypass Tray, Tray 1 (LCT), Tray 2, Tray 3,
Large Capacity Tray

Output Tray: Printer Default, Copy Tray, Finisher SR970/4000 Upper Tray,
Finisher SR970/4000 Shift Tray, Finisher SR4000 Booklet Tray,
Finisher SR841 Upper Tray, Finisher SR841 Shift Tray, Booklet
Processor Tray, Mailbox Tray 1-9

Resolution 600 dpi, 1200 dpi

Size: See General Setting Guide.

Staple: Off, Top Left, Top Right, 2 at Left, 2 at Right, 2 at Top, 2 at Cent-
er

Edge Smoothing On, Off

Toner Saving On, Off

Type:

See General Setting Guide.

Paper Selection

Same Paper for All Pages, Different Paper for First Page, Use
Slip Sheet, Chaptering

Punch:

Off, 2 at Left, 2 at Right, 2 at Top, 3 at Left, 3 at Right, 3 at Top,
4 at Left, 4 at Right, 4 at Top
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6. Appendix

Notes to Users of the PostScript 3 Driver

When using the PostScript 3 driver under Windows 2000/ XP/Vista, or Win-
dows Server 2003/2003 R2 on a client computer running Internet Explorer ver-
sion 6 or higher, some driver dialog boxes may be different from the illustrations
shown in PostScript 3 Supplement.

If this is the case, see the following explanations for the driver dialog boxes:
% Paper Size

Use this to select the size of paper you want to use.
The following table shows the tabs or menus where you can select this function.

Windows 2000/XP/Vista, Win- [Paper Size:] on [Paper Options] on the [Paper/Quality] tab

dows Server 2003/2003 R2 in the Printing Preference dialog box.
& Note
O For details about the paper sizes supported by this machine, see General
Setting Guide.

+ Fit to Paper
When the size of the document and paper size differ, set whether or not to
print according to paper size.

Windows 2000/ XP/Vista, Win- [Fit to Paper] on [Document Options] on the [Advanced]
dows Server 2003 /2003 R2 tab in the Printing Preferences dialog box.

¢ Prompt User
Print is performed with the size of document to be printed unchanged.

* Nearest Size and Scale
If the paper size is smaller than the selected paper size, the driver reduces
the print size.
If the paper size is larger than the size of document to be printed, print is
not to fit the paper size.

* Nearest Size and Crop

When the paper size is smaller than the size of document to be printed,
print is adjusted to meet the paper size.

< Resolution
Use this to set the resolution types.
The following table shows the tabs or menus where you can select this function.

Windows 2000/XP/Vista, Win- [Resolutions] on [Print Quality] on the [Paper/Quality] tab
dows Server 2003 /2003 R2 in the Printing Preferences dialog box.
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< Orientation Override

Use this to set the paper orientation.
The following table shows the tabs or menus where you can select this function.

Windows 2000/ XP/Vista, Win-
dows Server 2003/2003 R2

[Orientation Override] on [Document Options] on the [Ad-
vanced] tab in the Printing Preferences dialog box.

You can select the following items:

o [Off]
e [Landscape]
e [Portrait]

< Print Mode

Use this function to reduce the amount of toner used when printing.
The following table shows the tabs or menus where you can select this function.

Windows 2000/ XP/Vista, Win-
dows Server 2003/2003 R2

[Print Mode] on [Print Quality] on the [Paper/Quality] tab in
the Printing Preferences dialog box.

You can select the following items:

e [Through]
* [Edge Smoothing]
e [Toner Saving]

+ Duplex Printing

Use this function to select duplex printing.

iﬁklmportant

O To use this function, the optional duplex unit must be installed on the machine.
The following table shows the tabs or menus where you can select this function.

Windows 2000/ XP/Vista, Win-
dows Server 2003/2003 R2

[Print on Both Sides] on the [Finishing] tab in the Printing
Preferences dialog box.

o Off

Disables Duplex Printing.

* Long Edge

Prints output so that you can open it to the long edge when bound along

the long edge.
e Short Edge

Prints output so that you can open it to the short edge when bound along

the short edge.
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< Collate
Use this function to enable collation. With this feature, the machine can effi-
ciently print collated sets of multiple-page documents.

ﬂlmportant

O To use this function, a memory unit of at least 192 MB or hard disk drive
must be installed on the machine.

The following table shows the tabs or menus where you can select this function.

Windows 2000/ XP/Vista, Win- Set the number of copies to two or more, and then click
dows Server 2003 /2003 R2 the [Collate] check box on the [Paper/Quality] tab in the
Printing Preference dialog box.

« Paper Type
Use this to select the paper type.
The following table shows the tabs or menus where you can select this function.

Windows 2000/ XP/Vista, Win- [Media Type] on [Paper Options] on the [Paper/Quality] tab

dows Server 2003/2003 R2 in the Printing Preference dialog box.
& Note
O For details about the media type supported by this machine, see General
Setting Guide. m

« Destination Tray
Use this to select the destination tray.
The following table shows where you can select this function.

Windows 2000/ XP/Vista, Win- [Destination] on [Output Tray] on the [Finishing] tab in the

dows Server 2003/2003 R2 Printing Preference dialog box.
& Note
O For details about the destination tray supported by this machine, see Gen-
eral Setting Guide.
« Staple

Use this function to staple sheets of printed paper together.
The following table shows where you can select this function.

Windows 2000/ XP/Vista, Win- [Staple] on [Print Job] on the [Finishing] tab in the Print-
dows Server 2003/2003 R2 ing Preference dialog box.

4 Note

O The stapling location might differ depending on the orientation of the ma-
chine set in the printer and the orientation of the data to be printed.
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< Punch

Use this function to punch holes in the printed documents.
The following table shows where you can select this function.

Windows 2000/ XP/Vista, Win-
dows Server 2003 /2003 R2

[Punch] on [Print Job] on the [Finishing] tab in the Print-
ing Preference dialog box.

4 Note

O Punch positions and the number of punch holes that are available will
change depending on the type of finisher, the original's orientation, and
the printing paper size and orientation.

< Z-fold

Use this function to select the Z-fold type in the printed documents.
The following table shows where you can select this function.

Windows 2000/ XP/Vista, Win-
dows Server 2003/2003 R2

[Z-fold] on [Print Job] on the [Finishing] tab in the Print-
ing Preference dialog box.

< Watermark
Set the Watermark function.

Windows 2000/ XP/Vista, Win-
dows Server 2003/2003 R2

[Watermark] on the [Advanced] tab in the Printing Pref-
erences dialog box.

< Watermark Text

Select the Watermark Text type.

Windows 2000/ XP/Vista, Win-
dows Server 2003/2003 R2

[Watermark Text] on the [Advanced] tab in the Printing
Preferences dialog box.

« Watermark Font

Select the Watermark Font type.

Windows 2000/ XP/Vista, Win-
dows Server 2003/2003 R2

[Watermark Font] on the [Advanced] tab in the Printing
Preferences dialog box.

«» Watermark Size
Select the Watermark size.

Windows 2000/XP/Vista, Win-
dows Server 2003/2003 R2

[Watermark Size] on the [Advanced] tab in the Printing
Preferences dialog box.

+ Watermark Angle
Select the Watermark angle.

Windows 2000/XP/Vista, Win-
dows Server 2003 /2003 R2

[Watermark Angle] on the [Advanced] tab in the Printing
Preferences dialog box.
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% Watermark Style
Select the Watermark style.

Windows 2000/ XP/Vista, Win- [Watermark Style] on the [Advanced] tab in the Printing
dows Server 2003/2003 R2 Preferences dialog box.

+ Dithering
Use this to set the Image Rendering mode.
The following table shows the tabs or menus where you can select this function.

Windows 2000/ XP/Vista, Win- [Dithering] on [Document Options] on the [Advanced] tab
dows Server 2003/2003 R2 in the Printing Preferences dialog box.

You can select the following items:

e Auto
Use this setting to configure the best dithering method automatically de-
pending on the appearance of the document to be printed.
¢ Photographic
Performs dithering using an appropriate pattern for photographs.
o Text
Performs dithering using an appropriate pattern for text.

¢ User Setting
Use this setting to print images set in half tone in your application.

% Image Smoothing
Use this to select the image smoothing type.
The following table shows the tabs or menus where you can select this function.

Windows 2000/XP/Vista, Win- [Image Smoothing] on [Document Options] on the [Ad-
dows Server 2003/2003 R2 vanced] tab in the Printing Preferences dialog box.

o Off

Disables image smoothing.
* On

Performs image smoothing unconditionally.
e Auto

Performs image smoothing automatically for images that have a resolution
less than 25% of supported printer resolution.

* Less than 90 ppi - Less than 300 ppi
Performs image smoothing only when the image has an image resolution
(pixels per inch) less than the respective value you have selected in the list.

@ Note

O When [Auto] is selected, data processing may take a long time. When Image
Smoothing is used for a mask image, this function may have an undesired
effect on the print result.
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Specifications

This section contains the machine's electrical and hardware specifications, in-
cluding information about its options.

Component Specifications

Resolution 1200 x 1200 dpi
600 x 600 dpi
300 x 300 dpi

Printing speed e Typel:
60 ppm
e Type2:
70 ppm
¢ Type3:
80 ppm
(A4[), 8'/2 x 11 [J plain paper)
Printing speeds depend on the machine. Check which type of ma-
chine you have. See General Settings Guide.

Interface Standard:

¢ Ethernet interface (100BASE-TX/10BASE-T)
e TUSB 2.0 interface

Option:

o IEEE 1284 parallel interface

Use a standard 36-pin printer cable not longer than 3 meters (10
feet).

¢ IEEE 802.11b wireless LAN interface
¢ Bluetooth interface

e USB Host interface

¢ Ethernet interface (1000BASE-T)

Network protocol IPv4, IPv6, IPX/SPX, AppleTalk

Printer language Standard: PCL 6/5e, RPCS
Option: PostScript 3, PDF

Fonts PCL 6/5e:

Monotype Imaging 35 Intellifonts, 10 TrueType fonts, 13 Interna-
tional fonts, and 1 Bitmap font.

PostScript 3 :
136 fonts (Type 2:24, Type 14:112)

Memory 512 MB

Hard disk Storage capacity : 80 GB

Network cable 100BASE-TX/10BASE-T shielded twisted-pair (STP, Catego-
ry/Type5) cable.
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Component Specifications

USB Interface (Standard) | ® Supported Operating System:
Windows 2000/ XP/Vista, Windows Server 2003 /2003 R2, Ma-
cOS 10.3.3 or later

¢ Transmission spec.
USB 2.0 Standard

¢ Connectable Device:
Devices corresponding to USB 2.0 Standard

& Note
O When using Mac OS, use only the USB Interface (Standard). The optional USB
host interface board is not supported.

O When using the USB Interface (Standard) with Mac OS 10.3.3, USB2.0 is supported.

Options

ﬂlmportant
O Only one optional interface board can be installed in the machine at a time.

Therefore, the optional IEEE 802.11b interface unit, the IEEE 1284 interface
board, and Bluetooth interface unit cannot be installed concurrently.

IEEE 1284 Interface Board Type A

% Transmission spec.:
IEEE 1284

+« Required cable:
Standard IEEE 1284 compliant Micro Centronics 36 pin cable

IEEE 802.11b Interface Unit Type H

« Transmission spec.:
Based on IEEE 802.11b (wireless LAN)

< Protocol:
TCP/IP, IPX/SPX, AppleTalk

& Note
O SmartDeviceMonitor and Web Image Monitor are supported.

+ Data transfer speed:
Auto select from below speed

1 Mbps, 2 Mbps, 5.5 Mbps, 11 Mbps
+ Frequency range:

e Inch version:
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2412 - 2462 MHz (1 - 11 channels)

e Metric version:
2412 - 2472 MHz (1 - 13 channels)

<+ Transmittable distance:
1 Mbps 400 m
2 Mbps 270 m
5.5 Mbps 200 m
11 Mbps 140 m

& Note
O These figures are a guideline for outdoor use. In general, the transmittable
distance indoors is 10 - 100 m, depending on environment.

« Transmission mode:
Ad hoc, and infrastructure mode

Bluetooth Interface Unit Type 3245

% Supported Profiles:
e SPP (Serial Port Profile)
¢ HCRP (Hardcopy Cable Replacement Profile)
¢ BIP (Basic Imaging Profile)

+ Frequency Range:
2.45 GHz ISM band

« Data Transmission Speed:
723 kbps

@ Note

O The transmission speed is adjusted according to factors such as the dis-
tance and obstacles between the devices, radio signal condition and Blue-
tooth adaptor.

+« Maximum Range:
10 m
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USB Host Type A

< Interface Connector:
USB 1.1 host interface A type

« Data Transmission Speed:
12 Mbps (Full speed)

< Distance Between Devices:
25 m

Gigabit Ethernet Type 7300

% Interface Connector:
e Ethernet (10BASE-T, 100BASE-TX, 1000BASE-T)

e USB2.0
It requires a USB computer port and cable that support USB 2.0.

« Data Transmission Speed:

¢ Ethernet: 1000 Mbps, 100 Mbps, 10 Mbps

* USB: 480 Mbps (High speed: USB 2.0), 12 Mbps (Full speed)
< Protocol:

TCP /1P, IPX/SPX, AppleTalk
< Distance Between Devices:

e FEthernet: 100 m
e USB:5m

139



140

INDEX

B

H

Banner page, 37

Bidirectional communication, 47
Bluetooth connection, 44
Bluetooth interface unit, 138
Booklet finisher, 104

Bypass tray, 11

Cc

Hard disk, 136

Holding print jobs, 6

Hold print, 86

Hold print (deleting), 88
Hold print (printing), 87
How to read this manual, 1

Canceling a print job, 99

Changing the order of jobs, 6
Changing the port settings, 24
Chaptering, 115

Checking job history, 7

Checking jobs in the print queue, 5
Collate, 109

Configuring security mode settings, 46
Confirming the connection method, 17
Control panel, 8

Control panel (canceling a print job), 99
Covers, 111

Custom size paper, 11,14

D

IEEE 1284 interface board, 137
IEEE 802.11b interface unit, 137
Initial display, 2

Inserting chapter slip sheets, 116
Installing the printer driver, 21
Interface, 123,136

J

Job list, 4
Job list screen, 4

L

Data security for copying, 70
Deleting jobs, 7
DeskTopBinder Lite, 66
Display panel, 2

Document Server, 121

E

List per user ID, 93

Local connection, 20
Locked print, 82

Locked print (deleting), 85
Locked print (printing), 83
LPR port, 31

Error log, 101
F

Finisher, 104

Font Manager 2000, 50
Fonts, 136

Form feed, 37,97
Functions, 123

G

Mainframe, 123

Making option settings, 47
Manuals for this machine, i
Mask type, 72

Memory, 136

N

Gigabit ethernet, 139

NetWare print server, 35
Network cable, 136
Network connection, 17
Network printer, 19, 33
Network protocol, 136
No slip sheets, 115
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OHP transparencies, 15
Operating system, 136
Optional interface, 123
Options, 137

P

PageMaker, 51
Parallel connection, 42
PCL printer driver, 21, 33,35
PCL printer driver (IPP), 27
PCL printer driver

(printer properties), 53
PCL printer driver (TCP/IP), 25
PDF direct print, 65
PostScript 3, 129,131
Preparing the machine, 17
Printer Features menu, 8
Printer language, 136
Printer properties, PCL, 53
Printer properties, RPCS, 59
Printing after resetting the printer, 37
Printing all print jobs, 95
Printing a PDF file directly, 65
Printing in the security mode, 46
Printing method, 65
Printing speed, 136
Printing the selected print job, 93
Printing with Bluetooth connection, 45
Printjob, 74
Print job screen, 78
Punch, 107

Q

Quick Install, 21
R

Remote printer, 35
Resolution, 136
Rotating collate, 110
RPCS printer driver, 21,33, 35
RPCS printer driver (IPP), 27
RPCS printer driver
(printer properties), 59
RPCS printer driver (TCP/IP), 25

Sample print, 78
Sample print (deleting), 81
Sample print (printing), 79
Selecting the initial print job list, 77
Setting custom size paper
(Bypass tray), 14
Setting the paper size (Bypass tray), 13
Shift collate, 110
Simplified display, 3
Slip sheet, 117
SmartDeviceMonitor for Client port, 23
Specifications, 136
Spool printing, 102
Standard TCP/IP port, 29
Staple, 105
Stored print, 89
Stored print (deleting), 92
Stored print (printing), 90
Supported profiles, 44

T

Tab sheet, 118
telnet, 128
Thick paper, 15

U

Unauthorized copy control, 70
USB connection, 38

USB host, 139

User defined pages, 103

Using commands, 69

Using the print job function, 74

w

Web Image Monitor, 124
Windows 2000
(printer properties), 53, 59
Windows 2000 (USB connection), 38
Windows (canceling a print job), 100
Windows printing port, 17
Windows Server 2003/2003 R2 (printer
properties), 55,61
Windows Server 2003 /2003 R2
(USB connection), 40
Windows Vista
(printer properties), 57, 63
Windows Vista (USB connection), 41
Windows XP (printer properties), 55, 61
Windows XP (USB connection), 40

Y4

Z-fold, 119
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